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Chapter 1

Reports Overview

There are four main types of IBM® Sterling Control Center reports:

4+ Standard Sterling Control Center reports are produced from the Sterling Control Center
console, either on demand (Reports > Define/Run) or by scheduling them to be run at a
certain time and sent to designated recipients via e-mail (Reports > Automate).

The Audit Log is a standard report of changes made to IBM Sterling Connect:Direct server
configuration objects. It can be run as an on-demand report or displayed on screen (by
selecting Tools > Audit Log).

4+ Database reports use SQL queries or a third-party tool such as Crystal Reports to extract data
from the Sterling Control Center databases and create the reports. Sterling Control Center
provides several sample reports in Crystal Reports format that you can use with the Sterling
Control Center databases if you already have Crystal Reports. You can also use these samples
as templates to design your own reports. Data for Third-Party Reporting Tools provides details
of database schemas, including database tables and field definitions.

4+ Log file printouts are helpful for troubleshooting installation problems and other
support-related issues. The log files are stored in the ..\log subdirectory of the Sterling Control
Center installation directory. They can be accessed easily from the Tools menu on the Sterling
Control Center console (by selecting Tools > Trace Logs).

4 The SLC Debug Report is useful for troubleshooting an SLC. This report includes the SLC
definition, definition of all schedules referenced by the SLC, related SLC events produced for
the SLC, definition of rules triggered by the SLC events generated, definition of actions taken
by triggered rules, and the email system settings for the engine. This report is initiated from
the Control Center Console (by selecting Tools > Run SLC Debug Report).
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Chapter 2

Standard Reports

This chapter discusses the following subjects and procedures:
About Standard Reports

Create Reports

Run Reports on Demand

View or Modify Report Details

Automate Reports

Standard Reports: Configuration Management

Standard Reports: Monitoring

Standard Reports: Node Discovery

Standard Reports: System

R IR IR IR

IBM Sterling Control Center Reports Guide 9



Chapter 2 Standard Reports

About Standard Reports

Sterling Control Center includes a number of standard reports which you can create on demand or
via automation. Grouped into four categories, the report types include:

Report Category Report Name

Configuration Management * Functional Authorities Report * Sterling Connect:Direct Secure

Plus Cipher Suites Report

Initialization Parameters Report

Sterling Connect:Direct Secure
Plus Key Certificates Report

Netmap Communication Paths
Report

Sterling Connect:Direct Secure
Plus Nodes Report

Netmap Modes Report

Sterling Connect:Direct Secure
Plus Trusted Certifications Report

Netmap Nodes Report

User Proxies Report

Monitoring

Sterling Connect:Direct Process
Statistics Details

Sterling File Gateway Route Detail
by Producer

Sterling Connect:Direct Process
Statistics Summary

Sterling File Gateway Route Detail
by Consumer

Sterling Connect:Direct Statistics
Log Report

Sterling B2B Integrator Business
Process Details

Sterling Connect:Enterprise Batch
Statistics Details

Sterling B2B Integrator Business
Process Summary

Sterling Connect:Enterprise Batch
Statistics Summary

Sterling B2B Integrator File
Transfer Report

Sterling Connect:Enterprise
Statistics Log Report

High Watermark Report

FTP File Transfer Report

Sterling Connect:Direct File Agent
Process Submission Report

Node Discovery

Potentially Inactive Netmap Entries
Report

Netmap Connections Summary
Report

Potentially Missing Netmap Entries
Report

Node Discovery Topology Report

10
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About Standard Reports

Report Category

Report Name

System *

Alerts Report

Server Inventory Report

L 4

Audit Log Report

Server Status Report

Sterling Control Center License
Report

Service Level Criteria Summary
Report

Database Events Report

Users-Roles Summary Report

Monthly File Transfer Activity
Report

IBM Sterling Control Center Reports Guide
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Create Reports

To generate a Control Center report:

1.

2.
3.
4

10.

11.
12.

13.

14.
15.
16.

Select Tools > Reports > Define/Run to display the Report Listing.
Click + to display the Create Report dialog.
Select the report category and type you want to create.

For Configuration Management reports, to include non-current versions of configuration
objects in reporting, check Allow Selection of Non-current Versions. If you do not click this
option, only current versions of configuration objects are included.

Click Next.
To limit a report to certain criteria, specify those criteria and click Next.

Note: Specifying the same Key value more than once is treated as an AND condition. Example: To
narrow an Alerts report to a date/time range, specify report criteria similar to the following:
Alert Date/Time - Greater Than - Sept 30, 2010 00:00:00 America/Chicago
Alert Date/Time - Less Than -Today 00:00:00 America/Chicago

For more, see About Report Criteria on page 13 and Define Report Criteria on page 13.

Note: Not all reports allow you to specify criteria to narrow the report or to specify parameters.

In the Available Columns window, highlight the columns you want to appear in the report
and click >.

In the Selected Columns window, change the sort order of columns by selecting the column
name and clicking Move Up or Move Down.

The default sort order within columns is ascending. To sort a column in descending order,
highlight the column name and select .

To limit the report to a maximum number of records, type a value (up to 5000) in the Max
Records Returned field.

Click Next.

Click Run Report to generate the report. The report is displayed in a separate window called
the Reports Viewer. Familiar standard icons allow you to print or reload the report, navigate
through its pages, or change the report magnification percentage.

To save the report output as displayed in the Report Viewer, click [E], type a File Name, click
File Type to choose a different export format (if needed), and click Save.

Click [E to close the report output.
To save the report, type a Name and optional Description and click Save.
Click Close to close the Run Report window.

IBM Sterling Control Center Reports Guide 12



Create Reports

About Report Criteria

When you create or modify a report, the output may be limited by one or more filter criteria. At least
one criterion is required. The available criteria depend on the report type selected. For many reports,
the list of filter criteria is equivalent to the report’s available columns. See individual report
descriptions for details.

When filtering on Server or Server Group, you select from a list of managed servers/groups. For
Date and Time you select Relative to identify a date/time relative to report generation time, or
Absolute to select a specific date and time.

Wildcard characters can be used in the selection criteria for some reports and are as follows:

Wildcard Character Meaning

*

From this point to the end of the value the characters can be any combination.
Example 1: ‘C* represents any value that begins with the letter C.
Example 2: ‘proc* represents any value that begins with the letters ‘proc’.

The individual character in this exact position can be any character.

Define Report Criteria

To limit report output based on one or more criteria:

1.

From the Report Listing window, double-click the report to modify or click Create to create
a new report.

Do one of the following:

+ If you are modifying an existing report, click the Filter tab and select the criteria used to
limit the report output in the Key field.

+ If you are creating a new report, follow the prompts. When prompted for Filters, select a
filter criterion to use in the Key field.

Select the operator to use to further define the criteria. Choices of operator depend on type of
data. For example, numeric-based keys typically take an operator of “equal to,” 'not equal to,”
“greater than,” or “less than,” while character-based keys take operators of “matches,”
“doesn’t match,” and “contains.”

Note: Some reports also allow wildcard characters in the selection criteria. See About Report Criteria
on page 13.

Click the cell in the Value column and select an argument to finish defining the filter criterion.

Repeat steps 2 through 4 to define multiple selection criteria. Multiple criteria must all be true
for a record to be selected (they result in a logical AND condition).

Do one of the following:
+ If you are modifying an existing report, click Update.

¢ |f you are creating a new report, follow the prompts to complete the report. Refer to
Create Reports on page 12.
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View or Modify Report Details

To view or change report output:

1.

2
3.
4

Select Tools > Reports > Define/Run.

Double-click the report to view or modify.

Modify fields as necessary.
Click OK.

IBM Sterling Control Center Reports Guide
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Run Reports on Demand

To run a report:

1. From the Sterling Control Center menu, select Tools > Reports > Define/Run to display the
Report Listing window.

2. Select the report you want to run and click Run Report, or, to define a new report, click +,
and follow the prompts (see Create Reports on page 12). The Report Output window is
displayed. Icons in the report task bar allow you to save, print, or reload the report, navigate
through its pages, or change the degree of magnification.

3. To save the report, click [&]. Type a File Name, click File Type to choose a different export
format, and click Save. File types to which you can export a report include the following:

* PDF
¢ RTF* ODT (Open Document Text)
¢+ HTML

¢ Excel XLS (single sheet or multiple sheets)
¢ Comma-separated file (CSV)
¢ XML
¢+ Embedded images XML
4. Click o close the report, then click Close to close the Report Listing window.

Customize a Report

Once you create and save a report definition, you can run it any time. A report definition identifies
the criteria used to create the report output. Use the customize option to modify a report definition.

To customize a report:

1. Select Tools > Reports > Define/Run.
2. Highlight the report you want to customize and click [&.

3. Make changes as necessary to the existing filter criteria and click Update.

window.

5. To print the report, click |§| select print properties, and click OK.

6. To close the report output window, select [£F.
7. To save the report, type a report name and description and click Save.
Click Close to close the Report Listing window.

IBM Sterling Control Center Reports Guide 15



Print a Report
To print a report:
1. Select Tools > Reports > Define/Run.
2. Highlight the report you want to print.

3. Click Run Report |§| to generate the report. The report is displayed in a separate window.

4. To print the report, click [Z], select print properties, and click OK.

Remove a Saved Report
To remove a saved report:
1. Select Tools > Reports > Define/Run.
Highlight the report you want to remove and click -.

2
3. Click OK to remove the report.
4. Click [77 to close the Report Listing window.

Note: You cannot delete a report that is referenced by an automated report.
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Automate Reports

You can automate standard Sterling Control Center reports to run according to a defined schedule
and be sent to a list of email recipients.

Note: For UNIX systems, you must have an X11 graphics package on the UNIX host where the Sterling

Control Center engine is installed and a video card for graphics.

To automate a report:

1.
2.
3.

Click Tools > Reports > Automate. The Automated Report listing displays.
Click +. The Add Automated Report wizard displays.

Supply a Name and Description for the automated report and check Enabled to enable it.
Name is required. See Automated Reports Field Definitions on page 17 for detailed field
descriptions.

To schedule an existing report, highlight the report in the Reports list and click >. To create a
new report to schedule, click +. (See Create Reports on page 12 for more.) To create a new

report to schedule using an existing report as a starting point, select the report and click | & |.
Click Next. o
Select a Report Schedule and click >. Then click Next. Or, create a new schedule (click +
under the schedule list) or duplicate an existing one (click [& | under the schedule list).
Select a list of email recipients and click +. Then click Next. (You can also add or duplicate an
email list). See Maintain Automated Reports Email Lists on page 18.

Select a Report Format and report Attachment Extension. You can leave off the extension
or modify it to circumvent email attachment restrictions. Add a From email address and a
Subject line and click Next.

Review your entries and click Finish to create the automated report.

Automated Reports Field Definitions

Following are descriptions of automated reports fields.

Field Description
Name Automated report name.
Description A description of the automated report.

Report Schedule The schedule attached to the automated report. The schedule determines when the

automated report is generated and sent.

(List of recipients) ~ The name of the list or lists of email recipients for the automated report.

IBM Sterling Control Center Reports Guide 17



Field Description

Report Format Format of the automated report. Options are comma-separated (CSV), portable

document format (PDF), or Excel spreadsheet (XLS).

Attachment The file type or extension of the report file. You can specify no file type or an
Extension alternative type which can later be changed by the recipient to circumvent firewall

restrictions.

From The “from” address to be specified in the email.

Subject The subject line of the email.

Maintain Automated Reports Email Lists

Automated reports are generated and sent via email to lists of addressees. You can maintain these
lists of email addressees. Because you can specify more than one email list for an automated report,
you can maintain a list specifically for a given report or construct the list from multiple email lists.

To create an email list:

1.

2.
3.
4

6.

Click Manage > Email Lists.
Click +.
Add a Name (required) and Description for the new email list and click Next.

In the Email wizard panel, add email addresses to whom you want to send one or more
generated reports, separating the addresses with commas. You can click Import to import a
text file of email addresses. You can also click Export to export an email list to an external
text file. Click Next when finished adding addresses.

Limit the roles to grant permission to see and use this email list by selecting a role in the list of
All Roles and clicking >. Filter the list of roles by typing a filter criterion in Filter. Click Next.

Click Finish to finish creating the email list.

Later, when you create or modify an automated report, you can add this email list to the list of
addressees to receive the report.

Automated Reports Frequently Asked Questions

Following are solutions to issues that might arise with automated reports.

What could cause an automated report not to be delivered?

18

If an automated report fails to be delivered as expected, check for these conditions:

*
4
*

The email server could be down. Make sure it is up.
The output attachment size could exceed the limit allowed by the email server.

Email servers may strip attachments with certain extensions. To prevent this from happening,
double-click the report in the Automated Reports listing, click the Parameters tab, and change
the Attachment Extension. Inform recipients to change the file’s extension back after receiving
it via email to reflect the report’s format.

IBM Sterling Control Center Reports Guide



Automate Reports

4+ Email settings may not have been set up. Check on the Email tab of System Settings (on the
Manage menu).

4+ Make sure that the report schedule is correct.
If you are still having problems, look in the engine log file for errors.

Are there best practices to follow for automated reports?

It is a good idea to schedule automated reports to run when less activity is occurring on managed
servers. This reduces the impact of report generation on normal monitoring activity.

IBM Sterling Control Center Reports Guide 19



Standard Reports: Configuration Management

Sterling Control Center features reports that describe aspects of Sterling Control Center server
configuration management. These reports include:

¢ Functional Authorities Report ¢ Sterling Connect:Direct Secure Plus Cipher
Suites Report

¢ Initialization Parameters Report ¢ Sterling Connect:Direct Secure Plus Key
Certificates Report

¢ Netmap Communication Path Report ¢ Sterling Connect:Direct Secure Plus Nodes
Report
¢ Netmap Modes Report ¢ Sterling Connect:Direct Secure Plus Trusted

Certificates Report

¢ Netmap Nodes Report ¢ User Proxies Report

The following sections describe the available standard report types related to configuration
management. Sample reports are shown.

IBM Sterling Control Center Reports Guide 20



Functional Authorities Report

The Functional Authorities Report lists details about the functional authorities that have been set up
for Sterling Connect:Direct servers added to Sterling Control Center.

The following table describes the report columns:

Column Description

Server Name Name of the selected server.

Functional Authority Name The name of the functional authority.

Version Version of the functional authority.
Parameter The functional authorities parameters selected for this report.
Value Parameter value.

Parameters you can choose to report on in the Parameter column can be found in the “Functional
Authorities” chapter of the Sterling Control Center Configuration Management Guide.

Following is a sample report:

Functional Authority Report

Server Name
ccdev02_44_0

ccdev02_44 0

ccdev02_44_0

ccdev02_44_0

Page 2 of 2

Functional Authority Name

*admin

*GENUSR

cduser

pgounder

Version
2008/08/12 16:58:18

2008/08/12 16:58:18

2008/08/12 16:58:18

2008/08/12 16:58:18

Parameter
Admin

User Authority
User ID

User Proxy

Admin

User Authority
User ID

User Proxy

Admin

User Authority
User ID

User Proxy

Admin

User Authority
User ID

User Proxy

*GENUSR
N

Y
cduser
Y

Y
Y
pgounder
Y

Tue Aug 12 17:09:33 CDT

IBM Sterling Control Center Reports Guide
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Initialization Parameters Report

The Initialization Parameters Report lists initialization parameter (initparm) values for selected
servers. The listing is broken down by server and initialization parameter version.

The following table describes the report columns:

Column Description

Server Name Name of the selected server.

Initialization Parameters This column simply reflects that the object being reported upon is

Name initialization parameters.

Version Version of the initialization parameters. Version indicates the date and time

that the initialization parameters were last changed.

Parameter The specific initialization parameters that were selected for the report.

Value Parameter value.

The set of parameters you can choose to report on in the Parameter column vary depending on
server operating system. Definitions of the parameters can be found in the console in the form of
tooltips. When you hover the cursor over an initialization parameter its definition displays. You can
find further detail on initialization parameters in the Sterling Connect:Direct documentation set for
the relevant platform (z/OS, UNIX, or Microsoft Windows).

Following is a sample report:

Initialization Parameters Report

Server Name Initialization Parameters Name Version Parameter Value

CDW44.W2003.YM Initialization Parameters 2008/09/23 11:34:08  active.directory.enabled N
ckpt.interval 10240K
comm.bufsize 65535
conn.retry.ltattempts 10
conn.retry.ltwait 00:03:00
conn.retry.stattempts 10
conn.retry.stwait 00:00:10
contactname not specified
contact.phone not specified
continue.on.exception N
descrip no description specified
disable.cache N
download.dir C:\Program Files\Sterling Commerce\Connect Direct

v4.4.00\ServerDOWNLOAD\"

ecz.memlevel 4
ecz.windowsize 13
event.log All
exec.prio.default 7
file.exit <None>
license.management key C:\Program Files\Sterling Commerce\Connect Direct

v4.4.00\Serverdirectl Mkey2008.txt
log.commands Y

log select N
max.api.connects 10
name CDW44.W2003.VM
netmap.check N
node.check B
notify.level A
outgoing.address <None>
Page 10f 8 Tue Sep 23 11:34:20 CDT
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Netmap Nodes Report
The Netmap Nodes Report lists all nodes in the netmap of selected servers.

The following table describes the report columns:

Column Description

Server Name Name of the selected server.

Netmap Node Name The name of the netmap node.

Version Version of the netmap node.

Parameter The netmap node parameters selected for this report.
Value Parameter value.

Parameters you can choose to report on in the Parameter column can be found in *“Managing
Netmap Nodes” in the Sterling Control Center Configuration Management Guide.

Following is a sample report:

Netmap Node Report
Server Name Netmap Node Name Version Parameter Value
u_phoenix b3800 2008/08/12 13:10:21  Contact Name <None>
Contact Phone <None>
LU62 Profile Name phoenix
Max PNODE Sessions 255
Max SNODE Sessions 255
Node Name b3800
Session Type
Short Term Retries 3
Short Term Retry Interval 00:00:30
TCP Address phoenix
TCP Port 3814
u_phoenix c38 2008/08/12 13:10:21  Contact Name
Contact Phone
LU62 Profile Name phoenix
Max PNODE Sessions 255
Max SNODE Sessions 255
Node Name c38
Session Type
Short Term Retries 3
Short Term Retry Interval 00:00:30
TCP Address phoenix
TCP Port 3824
u_phoenix 3800 2008/08/12 13:10:21  Contact Name
Contact Phone
LU62 Profile Name phoenix
Max PNODE Sessions 255
Max SNODE Sessions 255
Page 2 of 4 Tue Aug 12 17:22:43 CDT
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Netmap Modes Report
The Netmap Modes Report lists the netmap modes associated with selected servers.

The following table describes the report columns:

Column Description

Server Name Name of the selected server.

Netmap Mode Name The name of the netmap mode associated with the server.
Version Version of the netmap mode.

Parameter The netmap mode parameters selected for this report.
Value Parameter value.

Parameters you can choose for the Parameter column can be found in “Managing Netmap Modes”
in the Sterling Control Center Configuration Management Guide.

Following is a sample report:

Netmap Mode Report
Server Name Netmap Mode Name Version Parameter Value
w_winbody44 Mode1 2008/08/12 17:17:41  Buffer Size 65535
CRC
Max Pacing Size 0
Max RU Size 65535
Max Sessions 0
Mode Name Mode1
Pacing Send Count 0
Pacing Send Delay 0
Protocol TCP/IP
Page 2of 2 Tue Aug 12 17:19:28 CDT
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Netmap Communication Path Report

The Netmap Communication Path Report lists communication paths (comm paths) associated with
the nodes in a server’s netmap.

The following table describes the report columns:

Column Description

Server Name Name of the selected server.

Netmap Communication Path  The name of the communication path.

Name

Version Version of the communication path.

Parameter The communication path parameters selected for this report.
Value Parameter value.

Parameters you can choose to report on in the Parameter column can be found in *“Managing
Netmap Communication Paths” in the Sterling Control Center Configuration Management Guide.

Following is a sample report:

Netmap Communication Path Report
Netmap Communication Path

Server Name Name Version Parameter Value
Netmap Communication Path Name TCPCommPath
Protocol TCP/IP
Remote Address 000000000000

jlegel-DT4400 TCPPath2 2008/09/22 17:37:51  Adapter Number Primary
Local SNA Network
LU Name
Mode Mode2
Netmap Communication Path Name ~ TCPPath2
Protocol TCP/IP
Remote Address 000000000000

Page2of 3 Mon Sep 22 17:37:51 CDT
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Sterling Connect:Direct Secure Plus Nodes Report

The Sterling Connect:Direct Secure Plus Nodes Report lists details about the Sterling
Connect:Direct Secure Plus Nodes used by selected servers to move data securely.

Following are the columns included in this report:

Column Description

Server Name Name of the server.

Sterling Connect:Direct Secure Plus Node Name  Name of the key certificate.

Version Version of key certificate.
Parameter Parameters to include in the report.
Value Value of the parameter in question.

Possible parameters to include in this report are defined inSterling Connect:Direct Secure Plus
“Managing Secure+ Nodes” in the Sterling Control Center Configuration Management Guide.

Following is a sample report:

Sterling Connect:Direct Secure Plus Node Report

Server Name Secure+ Node Name Version Parameter Value
hpag4000sp -Client 2008/09/22 14:18:14  Certificate Label hi DSP/certs/oper psxp01_1024_keycert.txt
Certificate Validation Definition
Client Authentication N
Enabled Protocol SsL
Host Name
Node Name .Client
Port Number
Trusted Cert Label /svshare/CDSP/certs/openssl/OpenSSLCAcert.txt

Use External Authentication

hpag4000sp .Local 2008/09/22 14:18:14  Certificate Label plus/cer igned/ 10 t.ixt
Certificate Validation Definition
Client Authentication N
Enabled Protocol TLS
Host Name
Node Name -Local
Port Number
Trusted Cert Label plus/cer igned/nokeyext/1024NESScert.txt
Use External Authentication N

hpag4000sp .SEAServer 2008/09/22 14:18:14  Certificate Label
Certificate Validation Definition
Client Authentication

Enabled Protocol DefaultToLN
Host Name

Node Name .SEAServer
Port Number 61366

Trusted Cert Label

Page 1 of 161 Mon Sep 22 14:18:26 CDT
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Sterling Connect:Direct Secure Plus Key Certificates Report

The Sterling Connect:Direct Secure Plus Certificates Report lists Sterling Connect:Direct Secure
Plus key certificates (certs).

The following table describes the report columns:

Column Description

Server Name Name of the server.

Sterling Connect:Direct Name of the key certificate.

Secure Plus Key Certificate

Name

Version Version of key certificate.

Parameter Parameters to include in the report. These include Data, Label Name, and
Passphrase.

Value The data contained in the certificate.

Parameters you can choose to report on in the Parameter column can be found in “Managing
Secure+ Nodes” in the Sterling Control Center Configuration Management Guide.

Following is a sample report:

Sterling Connect:Direct Secure Plus Key Certificate Report

Server Name Secure+ Key Certificate Name  Version Parameter Value
hpag4000sp /svshare/CDSP/certs/openssl/cdwopsxp0 2008/09/22 14:14:43  Data -----BEGIN ENCRYPTED PRIVATE KEY-----
1.1024_keycert.txt MIICoTAbBgkghkiGOw0BBQMwDgQISQMKkMDZwWLSsCAggABIICgO7wVA

CCxP4FgFzg
AepUB5D2FqRY/U25C+Cex5TNcutoFAUy3q831a5YzhNIUZAdIFOX1H4d8
2YwAVOO
gQ5t8WyWGBEZ08hMY4a0sy4TX8df5U4LbhbmthLGNjUSHKOOXOVH2Hg
Gcz6KN1SG
MQYNgjwKaWDFnw4kOwwoJHCAKWONCZYui3dTPfSbM6eR4cT7y56rS4
p7nOuXxEoV
EQOhZVJI+swEWDysE: 10y+tkbyn3V03BI WnNCsElaan
g5dLAWC
27gMgXfECITybrQTMD126HVh82cRf5f4yO4vyzq+if7muCtZOke6xRhOrTV
O1rN2
qYT4KjUxrkk8jwKOkMJDYEgFrznF4AuRKkT4POXvufvuBgBolbyGoH2eJAR
cHqDRP
iPMuGLd+FSDSV8/nCfSPy1paYDsmqgPxMjTRhyVJO6marduTmVw8bXdA
Gi6T4TeJM
TbIMkFodHS9MSpac6C+Mc1IBGgNpuBXzpWkigjgTY YNHglzJoKKARQZdI
bvu2+p
940NLjVhCuGecCWgIKRpbaehGqrad+k4y2abJeru4A/z0J5g1BeY/gQSpC/
PWSC
AwxYgLsbNuiJ7mRNUwIBW++p8egeZ7tj4hQD2nBoQmmHT/hh+Td+wkfZ
5iJys5T2d
n1f6ubyranK+GdOntdgXHSuW2VeXdua3Kcsv6Q+SMXPSy51/fVnV9I5CBz
dREVc2
TUr2pPM14J3wRsa5V6GI9zmg+zjA40HIxU+PWXncCZZ0wkencNHdrOah
Oyr/yl8A
k/HQjniBeeqN7qOWhY/Xe+7uf0BUOgWhqflzvTzA9B8gdPTw44V3QQ/bsY
hdby/i1
E4PeuD0=
-----END ENCRYPTED PRIVATE KEY-----
-----BEGIN CERTIFICATE-----
MIIDVCCAyeg g gkghkiGOWOBAQQFADASMQWWCgYDVQ
QKEWNTQOkx
DzANBgNVBACTBklydmluZzEOMAWGA1UECBMFVGV4YXMxCzAJBgNV
BAYTAIVTMB4X
DTA2MDYyMDE2MDAXOFoXDTE2MDYxNzE2MDAxOFowgYcxCzAJBgN
VBAYTAIVTMQ4w

DAYDVQQIEwVUZXhhczEMMA0oGA1UEChMDUONJMQswCQYDVQQLE
WJTVJEKMCIGA1UE

Page 1 of 27 Mon Sep 22 14:14:50 CDT
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Sterling Connect:Direct Secure Plus Trusted Certificates Report

The Sterling Connect:Direct Secure Plus Trusted Certificates Report lists available trusted
certificates.

The following table describes the report columns:

Column Description
Server Name Name of the server.
Sterling Connect:Direct Trusted certificate name.

Secure Plus Trusted
Certificate Name

Version Version of trusted certificate.

Parameter Trusted certificate parameter. Possible parameters include Data and Label.
Data is the trusted certificate data itself. Label name is the name by which
to identify the trusted certificate when it is imported.

Value Parameter value.

Following is a sample report:

Sterling Connect:Direct Secure Plus Trusted Certificate Report

Sterling Connect:Direct
Server Name Secure Plus Trusted Certificate Version Parameter Value
Name
hpag4000sp /svshare/CDSP/certs/openssl/OpenSSL  2008/09/22 14:20:44 Data - BEGIN CERTIFICATE-----

CAcert.ixt MIICITCCAf6g gIBAD )BAQQFADASBMQwWCgYDVQ
QKEWNTQOKx

DzANBgNVBACTBklydmluZzEOMAWGA1UECBMFVGV4YXMxCzAJBgNV
BAYTAIVTMB4X
DTA1MDkxOTE2NTUxMFoXDTE1MDkxNzE2NTUxMFowPDEMMA0GA1U
EChMDUONJMQ8w
DQYDVQQHEWZJcnZpbmcexDjAMBgNVBAGTBVRIeGFzMQswCQYDVQQ
GEwJVUzCBnzAN
BgkqhkiGOWOBAQEFAAOBJQAWGYKCGYEAG390HGKTG+VsrufLilSKAAVxK
WkyUQp+
L8Z55i08KwNmP8VMIkfQCk+4fryu00SimOMIeS/b8owk154gLwNcjJKDH
WsxPAFL
VONZKhh9gbiVzM/PttBpsh2YMMg3sNjPLVj4ce1aMP2cw+TQkJITFDO9Q
DFwgx0C
x+JqMi7T9JMCAWEAAaOBpjCBozAPBgNVHRMBAfSBEBTADAQH/MASGA
1UdDWQEAwWIB
hjAdBgNVHQ4EFgQUGAgWBpZe/PkDICaFmHT2z5erN46gwZAYDVROBFO
WWAAUGAgW
BpZe/PkDiCaFmHTz5erN46ihQKQ+MDwxDDAKBgNVBAoTATNDSTEPM
AOGA1UEBXMG
SXJ2aW5nMQ4wDAYDVQQIEWVUZXhhczELMAKGAT1UEBhMCVVOCAQ
AwDQYJKoZIhveN
AQEEBQADgYEAp4MQopUhOdKDQTAtUEM8+2Q43QXwxSTFigN1KW43
5qLgmR2wg8a7
h/lvZpxMoP7i3LNRZH9y3iNMgplh8oyLnydnaWwUmUVV9YJueO+Ajlsfnéw
TgHOV

0duPCJLxK9ZIECMJqGfY 1W1tsApypQHNo/kD+eGTleyjFvT9bvCKxzM=
----- END CERTIFICATE-----

Label Name Isvshare/CDSP/certs/openssl/OpenSSLCAcert.txt

hpag4000sp /svshare/certs/CDTestCert.txt 2008/09/22 14:20:44 Data - BEGIN CERTIFICATE-----
MIICsTCCAhqg AgIBATANBgkghkif QUFADCBkZELMAKGA1
UEBhMCVVMx
DjAMBgNVBAgMBVRIeGFzMQ8wDQYDVQQHDAZJcnZpbmexCzAJBGNV
BAoMAINDMQsw
CQYDVQQLDAJRQTEgMB4GA1UEAwwXbGJha2VyLmNzZy5zdGVyY29t
bS5jb20xJzAl

BgkqhkiGOWOBCQEWGExhcnJ5X0Jha2VyQHNOZXJjb21tLmNvb TAeFwow

Page 1 of 89 Mon Sep 22 14:20:49 CDT
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Sterling Connect:Direct Secure Plus Cipher Suites Report

The Ster
Sterling

ling Connect:Direct Secure Plus Cipher Suites Report lists the cipher suites associated with
Connect:Direct Secure Plus nodes.

The following table describes the report columns:

Column

Description

Server Name Name of the server.

Sterling Connect:Direct Secure Name of the cipher suite.
Plus Cipher Suite Name

Version Cipher suite version.

Parameter Cipher suite parameter. These include SSL (Secure Sockets Layer) and
TLS (Transport Layer Security).

Value The possible values for the two parameters are true or false.

Following is a sample report:

Sterling Connect:Direct
Secure Plus Cipher Suite Report
Server Name Secure+ Cipher Suite Name Version Parameter Value
hpag4000sp SSL_DHE_RSA_WITH_3DES_EDE_CB 2008/09/22 14:11:50 Name SSL_DHE_RSA_WITH_3DES_EDE_CBC_SHA
C_SHA
SsL true
TLS true
hpag4000sp SSL_DHE_RSA_WITH_DES_CBC_SHA 2008/09/22 14:11:50 Name SSL_DHE_RSA_WITH_DES_CBC_SHA
SSsL true
TLS true
hpag4000sp SSL_RSA_EXPORT_WITH_DES40_CB 2008/09/22 14:11:50 Name SSL_RSA_EXPORT_WITH_DES40_CBC_SHA
C_SHA
SSsL true
TLS true
hpag4000sp SSL_RSA_EXPORT_WITH_RC2_CBC_ 2008/09/22 14:11:50 Name SSL_RSA_EXPORT_WITH_RC2_CBC_40_MD5
40_MD5
SsL true
TLS true
hpag4000sp SSL_RSA_EXPORT_WITH_RC4_40_M 2008/09/22 14:11:50 Name SSL_RSA_EXPORT_WITH_RC4_40_MD5
D5
SSsL true
TLS true
hpag4000sp SSL_RSA_WITH_3DES_EDE_CBC_SH 2008/09/22 14:11:50 Name SSL_RSA_WITH_3DES_EDE_CBC_SHA
A
SSsL true
TLS true
hpag4000sp SSL_RSA_WITH_DES_CBC_SHA 2008/09/22 14:11:50 Name SSL_RSA_WITH_DES_CBC_SHA
SSsL true
Page1of 8 Mon Sen 22 14:12:01 CDT

IBM Sterling Control Center Reports Guide 29



User Proxies Report
The User Proxies Report lists the user proxies associated with selected servers.

The following table describes the report columns:

Column Description

Server Name Name of the selected server.

User Proxy Name The name of the user proxy.

Version Version of the user proxy.

Parameter The user proxy parameters selected for this report.
Value Parameter value.

Parameters you can choose to report on in the Parameter column can be found in the “Managing
User Proxies” chapter of the Sterling Control Center Configuration Management Guide.

Following is a sample report:

User Proxy Report

Server Name User Proxy Name Version Parameter Value
u_phoenix arajput@b3800 2008/08/12 17:22:44  Copy
Description
Download yes
Download Directory
Local User ID pgount

Process Directory
Program Directory

Remote Node b3800
Remote User ID arajput
Run Job

Run Task

Submit

Upload yes

Upload Directory

u_phoenix dande1@b3800 2008/08/12 17:22:44  Copy
Description
Download yes
Download Directory
Local User ID dande1

Process Directory
Program Directory
Remote Node b3800

Remote User ID dande1
Run Job

Run Task

Submit

Upload yes

Upload Directory

Page 2 of 3 Tue Aug 12 17:24:36 CDT
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Standard Reports: Monitoring

Sterling Control Center features reports that present details on the monitoring of Sterling Control

Center managed servers. These reports include:

¢ Sterling Connect:Direct Process Statistics
Details Report

Sterling File Gateway Route Detail by Producer
Report

¢ Sterling Connect:Direct Process Statistics
Summary Report

Sterling File Gateway Route Detail by Consumer
Report

¢ Sterling Connect:Direct Statistics Log Report

Sterling B2B Integrator Business Process Details
Report

¢ Sterling Connect:Enterprise Batch Statistics
Details Report

Sterling B2B Integrator Business Process
Summary Report

¢ Sterling Connect:Enterprise Batch Statistics
Summary Report

Sterling B2B Integrator File Transfer Report

¢ Sterling Connect:Enterprise Statistics Log
Report

High Watermark Report

¢ FTP File Transfer Report

Sterling Connect:Direct File Agent Process
Submission Report

The following sections describe the available standard report types related to server monitoring.

Sample reports are shown.

IBM Sterling Control Center Reports Guide
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Sterling Connect:Direct Process Statistics Details

The Sterling Connect:Direct Process Statistics Details report contains detailed statistics information
about Processes occurring on managed Sterling Connect:Direct servers during a specified time
period.The following table describes the report columns:

Column Description

Bytes Sent The number of bytes sent by the sending node.

Date Time Date and time that the statistics records were generated.

Record ID Record identifier (also known as statistic ID). See Event Type Descriptions in the

Sterling Control Center System Administration Guide for a list of statistic IDs.

Server Name Name of the managed server that generated the statistic record.

Remote Server Name of other server involved in the Process.

Process Name Sterling Connect:Direct Process name.

Process Number Identification number assigned to the Process.

Return Code Numeric code returned from a completed Process that indicates failure or

success. The following are the standard return codes:
¢ 0 indicates successful completion

¢ 4indicates a warning

¢ 8indicates an error

¢ 16 indicates a catastrophic error

Message ID Sterling Connect:Direct message identification number. See the appropriate
product and platform documentation for a description of message IDs.

Message Text Short message text associated with the message ID.

Destination File Name  Path and file name for the file received.

Following is a sample report:
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Date / Time Record ID
2008/09/23 11:03:09.880 Pl

Destination File Name

Message Text:
2008/09/23 11:03:10.610  Cl

Destination File Name

Message Text:
2008/09/23 11:03:11.700  CT

Destination File Name

Message Text:
2008/09/23 11:03:11.720  PT

Destination File Name

Message Text:
2008/09/23 12:12:52.410 Pl

Destination File Name

Message Text:
2008/09/23 12:12:52.850  Cl

Destination File Name

Message Text:

Page 1of 5

Sterling Connect:Direct Process Statistics Details Report

Server Name Remote Server
Q1A47M1 L2GISW2K3.GIS43

Q1A47M1 L2GISW2K3.GIS43

/mailbox/CDUSER/pshcdsat.out

Q1A47M1 L2GISW2K3.GIS43
/mailbox/CDUSER/pshcdsa.out

Copy step successful.

Q1A47M1 L2GISW2K3.GIS43

PROCESS TERMINATED.
Q1A47M1 UNIX.

Q1A47M1 UNIX.

Process Name

PSHCDSA1

PSHCDSA1

PSHCDSA1

PSHCDSA1

PSHUNIX1

PSHUNIX1

/home/nis01/monty/cdstuff/testfiles/output/pshunix1.out

SCPAO00OI

SVTM100I

Message ID Bytes Sent

0

56700

Tue Sep 23 15:02:46 CDT
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Sterling Connect:Direct Process Statistics Summary

The Sterling Connect:Direct Process Statistics Summary report contains summary statistics about
Processes occurring on managed Sterling Connect:Direct servers during the specified time period.

The following table describes the report columns:

Column Description

Date Time Date and time that the statistics record was generated.

Server Name Name of the managed server that generated the status record.
Process Name Sterling Connect:Direct Process hame.

Process Number Identification number assigned to each Process.

Submitter User ID of the user who submitted the Process.

Return Code Numeric code returned from a completed Process that indicates failure or success. The
following are the standard return codes:

0 indicates successful completion
4 indicates a warning

8 indicates an error

16 indicates a catastrophic error

Msg ID Sterling Control Center or Sterling Connect:Direct message identification number. See
the appropriate product documentation for a description of message IDs.

Message Text Short message text associated with the message ID.

Following is a sample report:

Sterling Connect:Direct Process Statistics Summary Report
Process Return
Date / Time Server Name Process Name Number Submitter Code Message ID
2008/09/19 07:15:47.570 A1B.ZOS.AT46  LOADO81 40223 QATEST 0
Message Text:
2008/09/19 07:15:47.830 A1B.ZOS.AT46  LOADO66 40218 QATEST 0 SVTM1001
Message Text: PROCESS TERMINATED
2008/09/19 07:15:49.060 A1B.ZOS.AT46  LOADO062 40217 QATEST 0
Message Text:
2008/09/19 07:15:51.400 A1B.ZOS.AT46  LOAD084 40228 QATEST 0
Message Text:
2008/09/19 07:15:52.350 A1B.ZOS.AT46  LOADO81 40223 QATEST 0 SVTM1001
Message Text: PROCESS TERMINATED.
2008/09/19 07:15:54.810 A1B.ZOS.AT46  LOADO62 40217 QATEST 0 SVTM1001
Message Text: PROCESS TERMINATED.
2008/09/19 07:15:54.890 A1B.ZOS.AT46  LOADO87 40238 QATEST 0
Message Text:
2008/09/19 07:15:55.340 A1B.ZOS.AT46  LOAD082 40241 QATEST 0
Message Text:
2008/09/19 07:15:55.760 A1BZOS.AT46  LOAD084 40228 QATEST 0 SVTM1001
Message Text: PROCESS TERMINATED.
2008/09/19 07:15:57.850 A1B.ZOS.AT46  LOADOSS 40247 QATEST 0
Message Text:
2008/09/19 07:15:59.390 A1B.ZOS.AT46  LOADO8S 40247 QATEST 0 SVTM1001
Message Text: PROCESS TERMINATED
2008/09/19 07:15:59.800 A1B.ZOS.AT46  LOADO8S 40250 QATEST 0
Message Text:
Page 1of 419 Fri Sep 19 16:48:02 CDT
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Sterling Connect:Direct Statistics Log Report

The Database Sterling Connect:Direct Statistics Log Report allows you to compose a report of
database statistical data based on the information that is important to you. You choose the database
fields to display and their sort order. You can also state filter criteria to limit the records to include
in the report. Filter criteria include any of the database statistics fields except for CC Name.

The database statistics fields you can choose from are listed and described in . An example follows
of the Sterling Connect:Direct Statistics Log Report.

Sterling Connect:Direct Stats Report
Msg Short Txt Node ID Node Type Process Name Return Code
K step completed. Exit code = w_winbodyd4 1 PROC44 0
w_winbody44 1 PROC44 0
a process step completed successfully w_winbodyd4 1 PROC44 0
jas completed successfully. w_winbody44 1 PROC44 0
Jas completed successfully. w_winbody44 1 PROC44 0
w_winbody44 1 PROC44 0
261 (name PROC44, SNODE w_winbody44 1 PROC44 0
xecuting
261 (name PROC44, SNODE w_winbody44 1 PROC44 0
xecuting
w_winbody44 1 PROC44 0
w_winbody44 1 PROC44 0
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Sterling Connect:Enterprise Batch Statistics Details Report

The Sterling Connect:Enterprise Batch Statistics Details Report contains detailed information
about batches on managed Sterling Connect:Enterprise servers during the specified time period.

The following table describes the report columns:

Column

Description

Start Date Time

Date and time that start-of-batch transmission information is received by the Sterling
Control Center engine.

End Date Time

Date and time that end-of-batch transmission information is received by the Sterling
Control Center engine.

Server Name

The server involved in the batch transmission.

Message ID Message ID resulting from the batch Process.

Status Batch status.

Mailbox ID Repository associated with the Sterling Connect:Enterprise batch
Batch ID User-assigned description of a Sterling Connect:Enterprise batch.

Batch Number

System-assigned number for each batch in a Sterling Connect:Enterprise repository.

Size Size of the batch file.

Flags Sterling Connect:Enterprise batch status flag. See the appropriate Sterling
Connect:Enterprise documentation for a list of batch status flags.

Function Function performed on the batch. See the Sterling Connect:Enterprise documentation

for a description of functions.

Following is a sample report:

Sterling Connect:Enterprise Batch Statistics Details Report
Batch

Start Date / Time End Date / Time Server Name  Message ID Status Mailbox ID BatchID Number Size Flags Function
2008/08/20 13:13:07.000  2008/08/20 13:13:07.000 QAAIX160 CNCEO151 0 CEU0302 CEU0302 105 0 ERA
2008/08/20 13:13:07.000  2008/08/20 13:13:07.000 QAAIX160 CNCEO015! 0 CEU0302 CEU0302L 31 0 ERA
2008/08/20 13:13:43.000  2008/08/20 13:13:49.000 QAAIX160 CNCEO013I 0 CEU0303 CEU0303 31 0 c
2008/08/20 13:13:49.000  2008/08/20 13:13:49.000 QAAIX160 CNCEO11l 0 CEU0303 CEU0303 31 0 EXT
2008/08/20 13:13:58.000  2008/08/20 13:13:58.000 QAAIX160 CNCEO151 0 CEU0303 CEU0303 31 0 ERA
2008/08/20 13:13:23.000  2008/08/20 13:13:32.000 QAAIX160 CNCEO12! 0 CEU0303 CEU0303L 105 52428800 ADD
2008/08/20 13:13:33.000  2008/08/20 13:13:38.000 QAAIX160 CNCEO0141 0 CEU0303 CEU0303L 105 52428800 T
2008/08/20 13:13:58.000  2008/08/20 13:13:58.000 QAAIX160 CNCEO015! 0 CEU0303 CEU0303L 105 0 ERA
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Sterling Connect:Enterprise Batch Statistics Summary Report

The Sterling Connect:Enterprise Batch Statistics Summary report contains summary information
about batches on managed Sterling Connect:Enterprise servers during the specified time period.

The following table describes the report columns:

Column

Description

Start Date Time

Date and time that start-of-batch transmission information is received by the Sterling
Control Center engine.

End Date Time

Date and time that end-of-batch transmission information is received by the Sterling
Control Center engine.

Server Name

The server involved in the batch transmission.

Message ID Message ID resulting from the batch Process.

Status Batch status.

Mailbox ID Repository associated with the Sterling Connect:Enterprise batch.

Batch ID User-assigned description of a Sterling Connect:Enterprise batch.

Function Function performed on the batch. See the Sterling Connect:Enterprise documentation

for a description of functions.

Batch Number

System-assigned number for each batch in a Sterling Connect:Enterprise repository.

Following is a sample report:

Start Date / Time

End Date / Time

Sterling Connect:Enterprise Batch Statistics Summary Report

Server Name  Message ID Status Mailbox ID Batch ID Batch Number Function

2008/08/20 13:13:07.000
2008/08/20 13:13:07.000
2008/08/20 13:13:43.000
2008/08/20 13:13:49.000
2008/08/20 13:13:58.000
2008/08/20 13:13:23.000
2008/08/20 13:13:33.000
2008/08/20 13:13:58.000

Page 1of 3

2008/08/20 13:13:07.000
2008/08/20 13:13:07.000
2008/08/20 13:13:49.000
2008/08/20 13:13:49.000
2008/08/20 13:13:58.000
2008/08/20 13:13:32.000
2008/08/20 13:13:38.000
2008/08/20 13:13:58.000

QAAIX160
QAAIX160
QAAIX160
QAAIX160
QAAIX160
QAAIX160
QAAIX160
QAAIX160
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CNCEO151
CNCEO151
CNCEO131
CNCEO111
CNCEO151
CNCEO12I
CNCEO0141
CNCEO151

© ©o ©o ©o o o o o

CEU0302
CEU0302
CEU0303
CEU0303
CEU0303
CEU0303
CEU0303
CEU0303

CEU0302
CEU0302L
CEU0303
CEU0303
CEU0303
CEU0303L
CEU0303L
CEU0303L

105
31
31
31
31
105
105
1056

ERA

Tue Sep 23 15:10:52 CDT
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Sterling Connect:Enterprise Statistics Log Report

The Database Sterling Connect:Enterprise Statistics Log Report allows you to compose a report of
database statistical data based on the information that is important to you. You choose the database
fields to display and their sort order. You can also state filter criteria to limit the records to include
in the report. Filter criteria include any of the database fields except for CC Name. For definitions
of these fields, see Sterling Connect:Enterprise Statistics Table (CE_STATS_LOG) on page 113.

An example follows of a Sterling Connect:Enterprise Statistics Log Report.

Sterling Connect:Enterprise Stats Report

Bytes Read Bytes Written Node ID Node Type Event ID Msg ID

0 0 qasles8 2 75969471413748207 CNCE009!
0 0 qasles8 2 75969471413748208 CNCEO006!
[ 3010 qasles8 2 75969471413748214 CNCEO003I
0 0 qasles8 2 75969471413748218 CNCEO006!
3010 0 qasles8 2 75969471413748220 CNCEO11l
0 0 qasles8 2 75969471413748265 CNCEO010!

Mon Sep 25 14:41:52 CDT
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FTP File Transfer Report

The FTP File Transfer Report presents information on file transfer activity for FTP servers managed
by Sterling Control Center.

The following table describes the columns included in this report.

Column Description

Event Date/Time Date and time of the transfer.

Process ID Process identifier for the Process used to transfer the file.

Return Code Return code returned for the file transfer.

Direction Direction of the file transfer with respect to the FTP server.

File Size Size of the file transferred, in bytes.

Submitter User ID of the user who submitted the Process.

Source Server from which the file was transferred (submitter for FTP PUTS).
Destination Server to which the file was transferred (submitter for FTP GETSs).

A sample FTP File Transfer Report follows.

FTP File Transfer Report
Return File

Event Date / Time Process ID Code Direction Size Submitter Source Destination

palani /chpst.log
2008/09/24 10:51:47.000 80102651756821492 0  inBound 90 palani palani /chpst.log
2008/09/24 10:51:51.000 80102651756821499 0  inBound 90 palani palani /notepad.cdp
2008/09/24 10:51:56.000 80102651756821503 0 inBound 363 palani palani /sedinst2.log
2008/09/24 10:52:23.000 80102651756821763 0  inBound 200 palani palani /syntp.log
2008/09/24 10:52:23.000 80102651756821767 0 inBound 191 palani palani /setup.log
2008/09/24 10:52:23.000 80102651756821771 0 inBound 163 palani palani /sedinst.log
2008/09/24 10:52:24.000 80102651756821775 0 inBound 161 palani palani /chpst.log
2008/09/24 10:52:25.000 80102651756821779 0  inBound 90 palani palani fticrdbus.log
2008/09/24 10:52:26.000 80102651756821783 0  inBound 32 palani

Page 1of 2 Wed Sep 24 10:52:59 CDT
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Sterling File Gateway Route Detail by Producer Report

The Sterling File Gateway Route Detail by Producer report presents detailed information on route
activity by producer for Sterling File Gateway servers.

The fields that make up this report are described in the following table.

Field Description

Producer The name of the partner who created and sent the arrived file involved in the Sterling
File Gateway file transfer.

Server The name of the Sterling File Gateway server being monitored.

Arr File Name

The name of the arrived file involved in the Sterling File Gateway file transfer.

Status The status of the arrived file involved in the Sterling File Gateway file transfer.
Arrived
Failed
Ignore

Consumer The name of the partner who received the arrived file involved in the Sterling File

Gateway file transfer.

Consumer File

The name of the file the consumer expects in their mailbox when delivery is
completed.

File Size Size of file transferred, in bytes.
Start Time The date and time the file transfer started.
End Time The date and time the file transfer ended.

A sample Sterling File Gateway Route Detail by Producer report follows.

Sterling File Gateway Route Detail Report (by Producer)

Producer Server Arr File Name
Palani1 neith-filegateway producer_file.zip

producer_file.zip

Status Consumer Consumer File File Size Start Time End Time

Routed 511 2009/07/22 15:29:34.000  2009/07/22 15:29:38.000
Route Complete  RQ103PGPConsumerF 2009/07/22 15:29:36.000  2009/07/22 15:29:37.000
Delivery Complete from_Palani1_20090722.txt 9 2009/07/22 15:29:37.000 2009/07/22 15:29:37.000

Message: Consumer destination mailbox is /RQ103PGPConsumerF/Inbox.

Route Complete RQ103PGPConsumerE 2009/07/22 15:29:37.000 2009/07/22 15:29:37.000

Delivery Complete from_Palani1_20090722.txt 9 2009/07/22 15:29:38.000 2009/07/22 15:29:37.000

Message: Consumer destination mailbox is /RQ103PGPConsumerE/Inbox.

Route Complete RQ103PGPConsumer 2009/07/22 15:29:38.000 2009/07/22 15:29:38.000
D

Delivery Complete from_Palani1_20090722.txt 9 2009/07/22 15:29:39.000 2009/07/22 15:29:38.000

Message: Consumer destination mailbox is /RQ103PGPConsumerD/Inbox.

Routed 511 2009/07/20 13:02:03.000 2009/07/20 13:02:06.000

Route Complete RQ103PGPConsumer 2009/07/20 13:02:05.000 2009/07/20 13:02:05.000
D

Delivery Complete from_Palani1_20090720.txt 9 2009/07/20 13:02:05.000 2009/07/20 13:02:05.000

Message: Consumer destination mailbox is /RQ103PGPConsumerD/Inbox.
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Sterling File Gateway Route Detail by Consumer Report

The Sterling File Gateway Route Detail by Consumer report presents detailed information on route
activity by consumer for Sterling File Gateway servers.

The fields that make up this report are described in the following table.

Field Description

Consumer Name of the partner who received the file involved in the File Gateway file transfer.

Consumer File

File Size Size of file transferred, in bytes.
Status The status of the arrived file involved in the File Gateway file transfer.
Arrived
Failed
Ignored
Producer The name of the partner who created and sent the arrived file involved in the File

Gateway file transfer.

Arr File Name The name of the arrived file involved in the File Gateway file transfer.
Start Time The date and time the file transfer started.
End Time The date and time the file transfer ended.

A sample Sterling File Gateway Route Detail by Consumer report follows.

Sterling File Gateway Route Detail Report (by Consumer)

Consumer Consumer File File Size  Status Producer Arr File Name Start Time End Time
Multi_Delivery2 multi_delivery_test.txt 1610 Delivery Failed Multi_Delivery multi_delivery_test.txt ~ 2009/03/19 08:55:03.000 2009/03/19 08:55:10.000

Message: Delivery is now failed while Delivering with error message: Delivery failed. Cause: Unable to access or verify mandatory service parameter.
multi_delivery_test.txt 1610 Delivery Failed Multi_Delivery multi_delivery_test.txt 2009/03/19 08:55:04.000 2009/03/19 08:55:10.000
Message: Delivery is now failed while Delivering with error message: Delivery failed. Cause: Unable to access or verify mandatory service parameter.
multi_delivery_test.txt 1610 Delivery Failed Multi_Delivery multi_delivery_test.txt 2009/03/18 17:14:50.000 2009/03/18 17:14:58.000
Message: Delivery is now failed while Delivering with error message: Delivery failed. Cause: Unable to access or verify mandatory service parameter.
multi_delivery_test.txt 1610 Delivery Failed Multi_Delivery multi_delivery_test.txt 2009/03/18 17:14:52.000 2009/03/18 17:14:58.000
Message: Delivery is now failed while Delivering with error message: Delivery failed. Cause: Unable to access or verify mandatory service parameter.
jpro.txt Delivery Failed Multi_Delivery jpro.txt 2009/04/06 10:54:38.000 2009/04/06 10:54:43.000
Message: Delivery is now failed while Delivering with error message: Delivery failed. Cause: Mailbox Repository Error.
jpro.txt 55 Delivery Failed Multi_Delivery jpro.txt 2009/04/06 10:54:38.000 2009/04/06 10:54:43.000

Message: Delivery is now failed while Delivering with error message: Delivery failed. Cause: Unable to access or verify mandatory service parameter.

RQ103PGPConsumerD from_Palani1_20090317.t 9 Delivery Complete  Palanit producer_file.zip 2009/03/17 15:53:01.000 2009/03/17 15:53:01.000
xt
Message: Consumer destination mailbox is /RQ103PGPConsumerD/Inbox.

from_Palani1_20090326.t 9 Delivery Complete  Palanit producer_file.zip 2009/03/26 16:39:34.000 2009/03/26 16:39:30.000
xt
Message: Consumer destination mailbox is /RQ103PGPConsumerD/Inbox.

from_Palani1_20090330.t 9 Delivery Complete  Palanit producer_file.zip 2009/03/30 08:52:50.000 2009/03/30 08:52:51.000
xt
Message: Consumer destination mailbox is /RQ103PGPConsumerD/Inbox.

IBM Sterling Control Center Reports Guide 41



Sterling B2B Integrator Business Process Details Report

The Sterling B2B Integrator Business Process Details Report presents detailed information on
business process activity for Sterling Integrator servers.

The fields that make up this report are described in the following table.

Field

Description

Event Date/Time

Date and time that the event was generated.

Event Type The type of event generated.
Node ID The identifier for the node that generated the business process.
Node Name The name of the node that generated the business process.

Process Name

The name of the process.

Process ID

The process identifier.

Event Return Code

The code returned by the process.

Message ID The identifier for the message associated with the event.
Step Name The step name associated with the event.
Step ID The identifier for the step associated with the event.

Advanced Status

Service-specific details about any errors that occurred for a step in this instance.

For list of advanced status messages, see the Sterling B2B Integrator product
documentation.

A sample of this report follows:

Sterling B2B Integrator Business Process Details Report
Event Return Message Step

Event Date / Time Event Type Node Id Node Name Process Name Process ID Code ID Step Name Id

2009/04/09 06:34:49.000 Process step started pgounder-I node1 CCC_Xfer_From_Winbody_ 199517 0 0 AssignService 4
Advanced Status:

2009/04/09 06:34:49.000 Process step started pgounder- nodel CCC_Xfer_From_Winbody_ 199517 0 [ CDServerPrimitiveBeginSession 5
Advanced Status:

2009/04/09 06:34:49.000 Process step started pgounder-I node1 CCC_Xfer_From_Winbody_ 199517 0 0 AssignService 6
Advanced Status:

2009/04/09 06:34:49.000 Process step started pgounder-I node1 CCC_Xfer_From_Winbody_ 199517 0 0 AssignService 7
Advanced Status:

2009/04/09 06:34:49.000 Process step started pgounder-I node1 CCC_Xfer_From_Winbody_ 199517 0 0 DecisionEngineService 8
Advanced Status: 1

2009/04/09 06:34:49.000 Process step started pgounder- nodel CCC_Xfer_From_Winbody_ 199517 [¢] [ ReleaseService 9
Advanced Status:

2009/04/09 06:34:49.000 Process step started pgounder-I node1 CCC_Xfer_From_Winbody_ 199517 0 0 CDServerBeginSession 10
Advanced Status: Inline End

2009/04/09 06:34:49.000 Process step started pgounder- node1 CCC_Xfer_From_Winbody_ 199517 0 [ CDServerCopyFrom "
Advanced Status: Inline Begin CDInterop_CopyFromWithLoop

2009/04/09 06:34:49.000 Process step started pgounder-I node1 CCC_Xfer_From_Winbody_ 199517 0 0 EchoService 12
Advanced Status:

2009/04/09 06:34:49.000 Process step started pgounder- node1 CCC_Xfer_From_Winbody_ 199517 0 [ AssignService 13
Advanced Status:
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Sterling B2B Integrator Business Process Summary Report

The Sterling B2B Integrator Business Process Summary Report presents summary information on
business process activity for Sterling Integrator servers.

The fields that make up this report are described in the following table.

Field Description

Event Date/Time Date and time that the event was generated.

Event Type The type of event generated.

Node ID The identifier for the node that generated the business process.

Node Name The name of the node that generated the business process.

Process ID The Process identifier.

Process Name The name of the Process.

Event Return Code The code returned by the Process.

Message ID The identifier for the message associated with the event.

Advanced Status Service-specific details about any errors that occurred for a step in this
instance.

For list of advanced status messages, see the Sterling B2B Integrator
product documentation.

A sample of this report follows:

Sterling B2B Integrator Business Process Summary Report
Event Return

Event Date / Time Event Type Node Id Node Name Process Name Process ID Code Message ID

2009/04/10 04:00:00.000 Process started pgounder- node1 AFTPurgeArchiveMailboxes 201641 0 0
Advanced Status:

2009/04/10 04:15:04.000 Process started pgounder- node1 CCC_FTP_Get_From_Phoenix 201658 0 0
Advanced Status:

2009/04/10 04:24:44.000 Process started pgounder-| nodel CCC_Xfer_From_Winbody_CD_To_GIS 201669 0 0
Advanced Status:

2009/04/10 03:44:44.000 Process started pgounder- node1 CCC_Xfer_From_Winbody_CD_To_GIS 201622 0 0
Advanced Status:

2009/04/10 03:45:04.000 Process started pgounder-1 nodet CCC_FTP_Get_From_Phoenix 201624 0 0
Advanced Status:

2009/04/10 03:14:53.000 Process started pgounder- node1 CCC_FTP_Get_From_Phoenix 201590 0 0
Advanced Status:

2009/04/10 03:04:44.000 Process started pgounder- node1 CCC_Xfer_From_Winbody_CD_To_GIS 201579 0 0
Advanced Status:

2009/04/10 02:44:53.000 Process started pgounder-1 node1 CCC_FTP_Get_From_Phoenix 201557 0 0
Advanced Status:

2009/04/10 10:24:44.000 Process started pgounder-| nodet CCC_Xfer_From_Winbody_CD_To_GIS 202068 0 0
Advanced Status:

2009/04/10 10:16:07.000 Process started pgounder- node1 CCC_FTP_Get_From_Phoenix 202058 0 0

Advanced Status:

Page 1of 2 Fri Apr 10 10:43:43 CDT
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Sterling B2B Integrator File Transfer Report

The Sterling B2B Integrator File Transfer Report presents summary information on
communications activity for Sterling Integrator servers.

The fields that make up this report are described in the following table.

Field

Description

Event Date/Time

Date and time that the event was generated.

Adapter Name

Name of the Sterling B2B Integrator adapter that generated the event.

Process Name

The name of the process.

Process ID

The process identifier.

Return Code

The code returned by the process.

Message ID

The identifier for the message associated with the event.

Orig Node

The originating node for the process.

Remote Node

The receiving node for the process.

Direction The direction of the transfer

File Size The size of file transferred.

Submitter ID The identifier for the process submitter.
Protocol The protocol used for the transfer.

Secure Mode

A flag indicating whether the transfer was accomplished via a secure connection.

A sample of this report follows:

Event Date / Time
2009/04/10 00:16:49.000 FTPClientAdapter

Destination File: CCCTest

2009/04/10 00:34:54.000 CDServerforCCC

Destination File: pgouni-l.txt
2009/04/10 00:47:02.000 FTPClientAdapter

Destination File: CCCTest

2009/04/10 01:15:11.000 CDServerforCCC

Destination File: pgouni-l.txt

2009/04/10 01:17:11.000 FTPClientAdapter

Destination File: CCCTest

2009/04/10 01:46:54.000 FTPClientAdapter

Destination File: CCCTest
2009/04/10 01:55:01.000 CDServerforCCC

Destination File: pgouni-l.txt

2009/04/10 02:17:21.000 FTPClientAdapter

Destination File: CCCTest

Adapter Name:

Sterling B2B Integrator File Transfer Report

Return Message Remote File Submitter Secure
Process Name Process ID Code ID Orig Node Node Direction Size Id Protocol Mode
CCC_FTP_Get_Fro 201389 0 node1 10.20.42.130: inBound 1607715 admin FTP none
m_Phoenix
Message Text:
CCC_Xfer_From_Wi 201402 0 0 node1 WINBODY420 inBound 30 admin Connect:  none

nbody_CD_To_GIS
Message Text:

CCC_FTP_Get_Fro 201424 0 nodel 10.20.42.130: inBound 1607715  admin FTP none
m_Phoenix

Message Text:
CCC_Xfer_From_Wi 201446 0 0 node1 WINBODY420 inBound 30 admin Connect:  none

nbody_CD_To_GIS
Message Text:

CCC_FTP_Get_Fro 201458 0 node1 10.20.42.130: inBound 1607715 admin FTP none
m_Phoenix

Message Text:
CCC_FTP_Get_Fro 201491 0 nodel 10.20.42.130: inBound 1607715  admin FTP none
m_Phoenix

Message Text:
CCC_Xfer_From_Wi 201492 0 0 node1 WINBODY420 inBound 30 admin Connect:  none

nbody_CD_To_GIS
Message Text:

CCC_FTP_Get_Fro
m_Phoenix

201525 0 node1 10.20.42.130: inBound 1607715  admin FTP none

Message Text:
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High Watermark Report

Server licenses often stipulate a maximum number of simultaneous sessions that can run on a
server. The High Watermark Report provides information to help manage Sterling Connect:Direct
licenses or node usage, perform audits of usage, or meet other reporting needs.

For example, you can use the report to determine whether the number of sessions a Sterling
Connect:Direct node is licensed for are ever reached and, if so, how often and for what periods. Do
this by setting the report limit equal to the license limit.

The High Watermark Report can also be used to see how many times sessions would be queued if
the number of concurrent sessions allowed were reduced. To do this, set the report session limit to
a value lower than the license limit.

In some cases Sterling Connect:Direct licenses specify an overall limit on the number of
simultaneous sessions, as opposed to a limit for each server. You can use the report in these cases
as well, to see whether you are violating your license agreement. Or use the report to determine what
would happen if the limit on simultaneous sessions were raised or reduced. The # Times sessions
exceeded limit column tells how many processes would have been queued to run later if the session
limit were enforced.

Note: The more times processes are queued instead of run immediately, the more times your processing
window for file transfers may be missed.

The start time of the longest period over limit—in conjunction with the Last time max reached
—can serve as an indicator of when the most Sterling Connect:Direct processing is occurring on
your systems.

Max Concurrent Sessions indicates the maximum number of processes that ran at the same time.
The # Times max reached column can indicate whether or not the maximum number of processes
running at one time was an aberration or whether it happens frequently. By reducing the report limit,
you can determine the typical number of processes running simultaneously by watching for an
increase in the # Times max reached value.

You can restrict High Watermark Report output to a range of dates and times, to specific servers or
server groups, and to a session limit. Default filter criteria preset for this report include Limit, Max
Process Duration, Data/Time, and Servers. You can change the presets at the time of creation.
Servers is the only one required.

After you confirm your choices and run the report, a status window displays the time elapsed since
the report was initiated, along with start date/time and end date/time criteria. A progress bar depicts
report generation progress and shows the date of the last statistics record processed.

Note: High Watermark reports may require an extended time to run. Press Background to perform other
Sterling Control Center tasks. You can stop the report by pressing Stop. When the report is
complete, press Show Report.

The report includes detailed statistics for each selected server or server group as well as summary
statistics across all selected servers.
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The following table describes the columns of the High Watermark Report.

Column

Description

An asterisk next to a server ID indicates that a process on this server
has exceeded the maximum duration.

Server Name

The server ID.

Max Concurrent Sessions

The peak number of sessions reached during the selected period.

# Times Max Reached

The number of occurrences within the selected period that Max
Concurrent Sessions was reached.

Last Time Max Reached

The date and time of the last point when Max Concurrent Sessions
was reached.

# Times Above Limit

The number of times the specified session limit was exceeded.

# Times Sessions Exceeded Limit

was at or above the session limit.

The number of sessions initiated while the session concurrency count

Last Time Limit Exceeded

The date and time of the point when the limit was last exceeded (not

the point when concurrent sessions returned below the threshold).

Start Time of Longest Period

Over Limit

The date and time when the longest over limit period began.

Longest Period Over Limit

The amount of time in the longest over limit period.

% Time Over Limit

The percent of the total date/time range that the server or servers
spent over the limit.

# Processes Exceeding Max

Duration

How many processes have exceeded the maximum process duration.

Longest Process Exceeding Max

Duration

maximum process duration.

The running time for the process that has furthest exceeded the

Following is a sample High Watermark Report.

Server
Name

All Servers
jrandall297
ga160aix
gai60sol
qasles10
gasles11
qasles8
gasol10
svhppag

Max

Number of

High Watermark Report

Concurrent Times Max Last Time

© 0o oo 00 o n N

Max

Wed Sep 24 10:26:35 CDT
Wed Sep 24 10:26:35 CDT
Wed Sep 24 00:00:00 CDT
Wed Sep 24 00:00:00 CDT
Wed Sep 24 00:!
Wed Sep 24 00:00:00 CDT
Wed Sep 24 00:00:00 CDT
Wed Sep 24 00:00:00 CDT
Wed Sep 24 00:00:00 CDT

Number of
Times
Above Limit

1

© o o o oo o =

Note: * indicates Server with Process exceeding Maximum Process Duration found during specified Report Range

Number of

Times

Session

Exceeded Last Time Start Time of Longest Longest Period
Limit Limit Exceeded Period Over Limit Over Limit
2 Wed Sep 24 10:26:35 CDT Wed Sep 24 10:26:35 CDT  0:00:00

2 Wed Sep 24 10:26:35 CDT Wed Sep 24 10:26:35 CDT  0:00:00

0 0:00:00

0 0:00:00

0 0:00:00

0 0:00:00

0 0:00:00

0 0:00:00

0 0:00:00

Percentage of
Time

Over Limit

0

© o ©o o oo o o
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High Watermark Report Considerations

The statistics featured in the High Watermark Report may prove easier to understand by viewing a
series of graphics that show sessions starting and ending over a time span. In the examples, the time
span covers 19 generic units. The report is based on the following series of events, which occurred
on a managed server.

Time Event Time Event

1 Process Start 9 Process End
2 Process Start 10 Process Start
2 Process Start 11 Process Start
3 Process End 12 Process Start
3 Process End 14 Process End
4 Process Start 15 Process Start
4 Process Start 16 Process End
6 Process Start 17 Process End
7 Process End 18 Process End
8 Process End

session limit =2
# times sessions exceeded limit = 6

o roT
\>

limit - —

——
Tme 1 2 3 4 5 6 7 8 9 10 11 12 13 14 151617181‘9
|

Report Time Frame

IBM Sterling Control Center Reports Guide a7



48

maximum concurrent sessions = 4

2 & A # times max reached = 3
k=) e
o 5_ 1
&
1 4_ L
3_ |
Iimit——2—_—_—— —————————————— — -
11
e
Tme 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19
- . ~|
Report Time Frame
# times above limit = 3
2 g A
9 e
@ 5_ 1
A
T+ 4_ L
3_ |
Iimit——2——_—— —————————————— — -
11
e
Tme 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19

~|
Report Time Frame
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last time limit exceeded = 11
0 A
RS e
? 5_1
&
w 4
3_ |
imit- -2+ — L ¢ d—- - L o 1 — -
11
T e S
Tme 1 2 3 4 5 6 7 8 9 10 11 1213 14 15 16 17 18 19
- . >~ |
Report Time Frame
(OL = over limit)
2 g A OLper?odAzlt?meun?t
s T OL period B = 4 time units
S 5_ | OL period C = 6 time units
o]
)
w 4
3_ |
limit- — 2 — L ¢ = - [ SRR - -
11
e
Tme 1 2 3 4 5 6 7 8 9 10 11 1213 14 15 16 17 18 19
- . -
Report Time Frame

In the above illustration:

4 Start Time of Longest Period Over Limit =11

4 Longest Period Over Limit = 6 time units

4 Percent Time Over Limit = (1+4+6 units) / 19 units = 57.89%

All Servers Statistics. On the High Watermark Report, the results detailed for All Servers may not
make intuitive sense at first glance. The source of the confusion has to do with the nature of what
is being quantified.

For example, take a High Watermark Report run against two nodes, A and B, each with a session
limit of 1. If the two nodes behave identically, as in the following graphic, each will have a number
of sessions over the limit equal to two.
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However, the number of sessions in which the two combined are over the limit is six, as shown in
the next graphic. Therefore, the report column # Times Sessions Exceeded Limit will show a value
of 6 for All Servers.

e A+B

6_ | (O Over limit

S_ |
g @ ®
DR 0
*= ‘T @ ®

1— [ ) @ [ J ®

TS G S
Time
— >

Caveats. Keep in mind these caveats in using and interpreting the High Watermark Report.

4+ If the clocks are not accurate for all managed servers included in the report, the values for All
Servers may not be accurate.

4+ For Sterling Connect:Direct for Microsoft Windows version 4.2, in the absence of the fix for
SR1343840, whenever Processes are put on the wait, hold, or timer queues, they are treated as
still running. This may affect the accuracy of the report. No fix is needed with later versions of
Sterling Connect:Direct for Microsoft Windows.

During the report’s specified time frame, if one or more Processes exceed the Max Process Duration
value specified, the report’s accuracy will be affected.
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Sterling Connect:Direct File Agent Process Submission Report

The Sterling Connect:Direct File Agent Process Submission Report presents information on
Processes submitted by file agents associated with a managed Sterling Connect:Direct server.

The fields that make up this report are described in the following table.

Field Description
Date / Time Date and time that the event was generated.
Server Name ID of the server the file agent submitted the process to.

File Agent Name The identifier of the file agent.

Process Name The name of the submitted Process.

Process Number Number of the submitted Process.

Return Code The code returned by the Process.

Trigger File The name of the file that triggered the Sterling Connect:Direct File Agent to submit a
Process.

Rule Name The name of the Sterling Connect:Direct File Agent rule that triggered the event.

A sample of this report follows:

Sterling Connect:Direct File Agent Process Submission Report
Process Process Return

Date / Time Server Name File Agent Name  Name  Number Code Rule Name Trigger File

2010/08/23 09:06:59.000 dvarnell FileAgent TESTDMV 1 0 default c:\program
files\fileagent1300C\watch\FileAgent_InstallLog.log

2010/08/23 09:07:00.000 dvarnell FileAgent TESTDMV 2 0 default c:\program files\fileagent1300C\watch\output.txt

2010/08/23 09:07:01.000 dvarnell FileAgent TESTDMV 5 0 default c:\program files\fileagent1300C\watch\CDFA.log

2010/08/23 09:07:01.000 dvarnell FileAgent TESTDMV 3 [ default c:\program
files\fileagent1300C\watch\CDFA _stats.log

2010/08/23 09:07:01.000 dvarnell FileAgent TESTDMV 4 0 default c:\program
files\fileagent1300C\watch\CDFAConfigGuide.pdf

2010/08/23 09:08:59.000 dvarnell FileAgent TESTDMV 6 0 default c:\program files\fileagent1300C\watch\OGNL-
LICENSE .txt

2010/08/23 09:08:59.000 dvarnell FileAgent TESTDMV 7 0 default c:\program files\fileagent1300C\watch\OVAL-
LICENSE .txt

2010/08/23 11:17:04.058 dvarnell FileAgent 8 default c:\program files\fileagent1300C\watch\cvslist.txt

2010/08/23 11:18:03.000 dvarnell FileAgent TESTDMV 1 0 default c:\program files\fileagent1300C\watch\cvslist.txt

Page 1of 3 Mon Aug 23 11:19:07 CDT
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Standard Reports: Node Discovery

Sterling Control Center features reports that give details on aspects of Sterling Control Center node
discovery. These reports include:

¢ Potentially Missing Netmap Entries Report ¢ Netmap Connections Summary Report

¢ Node Discovery Topology Report ¢ Potentially Inactive Netmap Entries Report

The following sections describe the available standard report types related to node discovery.
Sample reports are shown.
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Potentially Inactive Netmap Entries Report

The Potentially Inactive Netmap Entries Report lists nodes identified during Node Discovery that
were found in the network map file of an Explorer node but on which no statistics records were
found. Use this information to determine if you need to remove these node definitions from the
network map of the corresponding Explorer node after validating that the connections to these

nodes are no longer required.

The following table describes the report columns:

Column Description

Server

Name of the Sterling Connect:Direct server.

Potentially Inactive Netmap Entry  The network map entry that may be inactive.

for Node(s)

Following is a sample report:

Server

JRANDALL
JRANDALL
JRANDALL
JRANDALL

Node Discovery Potentially Inactive Netmap Entries Report

Potentially Inactive Netmap Entry for Node(s)
CCDEV02
JRANDALL4400
MYNODE
TEST3

Page 1of 2

Wed Sep 24 10:20:06 CDT
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Potentially Missing Netmap Entries Report

The Potentially Missing Netmap Entries report identifies the nodes that were found in the statistics
records of the Explorer node but were not defined in the network map file. Use this information to
determine if you need to add these node definitions to the network map of the corresponding server.

The following table describes the report columns:

Column Description

Server Name of the Sterling Connect:Direct server.

Potentially Missing Netmap Entry  The nodes found in statistics records that were not defined in the
for Node(s) network map.

Following is a sample report:

Node Discovery Potentially Missing Netmap Entries Report

Server Potentially Missing Netmap Entry for Node(s)
JRANDALL MYNODE

Page 1of 2 Wed Sep 24 10:28:53 CDT
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Netmap Connections Summary Report

The Netmap Connections Summary Report contains a summary of all connection information
collected during Node Discovery.

The following table describes the report columns:

Column

Description

Server Name

Name of the Sterling Connect:Direct servers.

Netmap Entries

The number of network map entries defined.

Last Used Date/Time

The last time the server connected with another node.

API Address The TCP/IP address and port used by Sterling Control Center to establish a
session with the Sterling Connect:Direct server.

DTF Address The TCP/IP address and port of the server that a remote Sterling Connect:Direct
server uses to establish a connection.

Platform The platform on which the server is running.

Number of Partner
Nodes

The number of partner nodes defined in the network map and the statistics
records of the server.

Explorer/Discovered

The type of node. E = nodes defined in the Explorer List and D = nodes located
in the Discovery List.

Following is a sample report:

Netmap

Page 1 of 1

Netmap Connection Summary Report

Number of Explorer /

Server Name Entries Last Used Date/ Time APl Address DTF Address Platform Partner_Nodes Discovered
N/A 0 10.20.246.36:3313 1 E
N/A 0 WINBODY:4363 1 E
N/A 0 CCDEV01.CSG.STERCOMM.COM: 1 E
N/A 0 10.20.4.222:1363 1 E
N/A 0 10.20.9.56:3383 1 E
N/A 0 JRANDALLXP.CSG.STERCOMM. 1 E

Fri Oct 20 11:13:03 CDT
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Node Discovery Topology Report

The Node Discovery Topology report contains information about the partners associated with the

specified Explorer node.

The following table describes the report columns:

Column

Description

Explorer Node Name

The name of the server defined in the Explorer List.

API Address The TCP/IP address and port used by Sterling Control Center to
establish a session with the Sterling Connect:Direct server.

DTF Address The TCP/IP address and port of the server that a remote Sterling
Connect:Direct server uses to establish a connection.

Platform The platform on which the server is running.

License Key Expiration Date

The date the license key expires for the node.

Last Explored Date Range

The date range used to search the last time that Node Discovery was
run.

Last Explored Date/Time

The date and time that Node Discovery was last run.

# Partners

The number of partner nodes defined in the network map and found in
statistics records for the server.

# Processes

The number of Processes found in the statistics records during Node
Discovery.

Discovered Node Name

The name of a server found during Node Discovery.

Found in Netmap/Stats/Both

Identifies where the discovered node was found: either defined in the
network map, in a statistics record, or identified in both the network map
and a statistics record.

IP Address/APPL ID

The IP address or the APPL ID for SNA-enabled nodes.

Data Transfer Port

The port used for data transfer.

Platform

The platform on which the discovered node is running.

Last Used Date/Time

The time stamp of the communications between server pair under
consideration.

# Explorer Partners

The number of Explorer nodes that this node communicates with.

# Processes

The number of Processes found in the statistics record for the server
pair under consideration.
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Following is a sample report:

Explorer Node Name

Q1B.Z0S.V4600

Discovered Node Name

Explorer Node Name

CDW44.W2003.VM

Discovered Node Name

Explorer Node Name

JLEGEL-DT4400

Discovered Node Name

Page 1of 4

API Address

10.20.129.8:8225

Found in

Netmap/Stats/Both

API Address

10.20.234.43:1363

Found in

Netmap/Stats/Both

API Address

10.20.4.247:1363

Found in
Netmap/Stats/Both

Node Discovery Topology Report

DTF Address

10.20.129.8:8224

IP Address/APPL ID

DTF Address

10.20.234.43:1364

IP Address/APPL ID

DTF Address

10.20.4.247:1364

IP Address/APPL ID

Platform License Key
Expiration Date

08390 4600 2009/10/30
14:47:28.101

Data Transfer Port  Platform

Platform License Key
Expiration Date

WINDOWS 4450 2008/12/26
15:47:11.333

Data Transfer Port  Platform

Platform License Key
Expiration Date

WINDOWS 4451 2008/12/26
15:47:24.250

Data Transfer Port  Platform

Last Explored Date Range

Last Used Date/Time

Last Explored Date Range

Last Used Date/Time

Last Explored Date Range

Last Used Date/Time

Last Explored
Date/Time

# Explorer Partners

Last Explored
Date/Time

# Explorer Partners

Last Explored
Date/Time

# Explorer Partners

# Partners

# Processes

# Partners

# Processes

# Partners

# Processes

# Processes

# Processes

# Processes

Tue Sep 23 11:38:51 CDT
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Standard Reports: System

Sterling Control Center features reports that detail aspects of overall system functioning. These
reports include.

¢ Alerts Report ¢ Server Inventory Report

¢ Audit Log Report ¢ Server Status Report

¢ Database Events Report ¢ Service Level Criteria Summary Report
¢ Monthly File Transfer Activity Report ¢ Users and Roles Summary Report

The following sections describe the available system standard report types. Sample reports are
shown.
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Alerts Report

The Alerts Report contains information about alerts generated by Sterling Control Center on
managed servers during a specified time period. The report includes any comments that may have
been entered for an alert. For more on alert comments, see “Updating Alerts” in the Sterling Control
Center User Guide.

The following table describes the report columns:

Column

Description

Alert Date Time

Date and time that the alert was generated.

Severity

Alert severity level. (0-3)

Server Name

Name of the managed server on which the alert was generated.

Proc/Batch Name

Process name or Batch ID that generated the alert.

Proc Number

Process or batch number that generated the alert.

Rule Name

Rule that triggered the alert.

User Data 1-4

User-definable metadata fields. See Managing Metadata in the IBM Sterling Control
Center System Administration Guide or the Help system.

Handled Time

Time that the alert was handled.

Alert Handled

A flag indicating whether the alert was handled (Y/N).

Handled By

User ID of the Sterling Control Center user who handled the alert.

Comments

User comments supplied when the alert was handled.

Following is a sample report:

Process / Batch Process Alert

Alert Date / Time Severity Server Name Name Number Rule Name Handled Time Handled Handled By
2007/09/25 10:14:39.000 1 sv160dell3 CCWINRT 13088 Bad Return Code

2007/09/27 12:56:45.000 1 sv160dell3 FILESLC 13122 Bad Return Code

2007/09/27 13:13:26.000 1 sv160dell3 FILESLC 13123 Bad Return Code

2007/09/27 17:39:39.000 1 sv160dell3 FILESLC 13145 Bad Return Code

2007/09/28 09:59:32.000 1 sv160dell3 FILESLC 13147 Bad Return Code

2007/09/28 13:11:40.663 2 qasles8 Linked rule 1

2007/09/28 13:12:04.217 2 winbody Linked rule 1

Alerts Summary Report
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Audit Log Report

The Audit Log Report lists changes that have been made to the configuration of one or more
Sterling Connect:Direct servers managed by Sterling Control Center.

The following table describes the report columns.

Column Description

Date Time Date and time of the change.

User User ID of the user who made the change.

Server The server the change affected.

Object ID The identifier of the object that was changed.

Object Type The type of object changed.

Property The specific property of the object that was changed.
Type Type of property change: Added, Modified, or Deleted.
Value Before The value of the property before the change.

Value After The value of the property after the change.

Following is a sample report.

Audit Log Report

Date Time User Server  Object ID Object Type Property Type Value Before Value After

2008/09/22 13:58:07.011  admin Q1B.ZOS.V Q1B.ZOS.V4600,A Functional Confirm Delete Added Y
4600 USER Authority

2008/09/22 13:58:07.011  admin Q1B.Z0OS.V Q1B.ZOS.V4600,A Functional Reset Signon Added Y
4600 LLUSER Authority

2008/09/22 13:58:07.011  admin Q1B.ZOS.V Q1B.ZOS.V4600,A Functional Confirm Delete Added Y
4600 LLUSER Authority

2008/09/22 13:58:07.011  admin Q1B.Z0OS.V Q1B.ZOS.V4600,A Functional Secure+ Admin Added Y
4600 LLUSER Authority

2008/09/22 13:58:07.011  admin Q1B.ZOS.V Q1B.ZOS.V4600,A Functional update_user Deleted Y
4600 LLUSER Authority

2008/09/22 13:58:07.011  admin Q1B.ZOS.V Q1B.Z0OS.V4600,A Functional Flush Deleted A
4600 LLUSER Authority

2008/09/22 13:58:07.011  admin Q1B.ZOS.V Q1B.ZOS.V4600,A Functional Refresh Deleted Y
4600 LLUSER Authority

2008/09/22 13:58:07.011  admin Q1B.ZOS.V Q1B.ZOS.V4600,A Functional Security ID Modified *** b
4600 LLUSER Authority

2008/09/22 13:58:07.011  admin Q1B.ZOS.V Q1B.ZOS.V4600,A Functional Password Modified *** i
4600 LLUSER Authority

2008/09/22 13:58:07.011  admin Q1B.ZOS.v Q1B.ZOS.V4600,A Functional Security ID Modified *** e
4600 USER Authority

2008/09/22 13:58:07.011  admin Q1B.ZOS.V Q1B.ZOS.V4600,A Functional Password Modified *** -
4600 LLUSER Authority

2008/09/22 13:58:45.661 admin Q1B.ZOS.V Q1B.ZOS.V4600,A Functional Reset Signon Added N
4600 LLUSER Authority

2008/09/22 13:58:45.661 admin Q1B.ZOS.v Q1B.ZOS.V4600,A Functional Update APKEY Added Y
4600 LLUSER Authority

2008/09/22 13:58:45.661 admin Q1B.ZOS.V Q1B.ZOS.V4600,A Functional Confirm Delete Added Y
4600 LLUSER Authority

2008/09/22 13:58:45.661 admin Q1B.ZOS.V Q1B.ZOS.V4600,A Functional Update Initialization ~ Added Y
4600 LLUSER Authority Parameters

2008/09/22 13:58:45.661  admin Q1B.ZOS.V Q1B.ZOS.V4600,A Functional Confirm Delete Added Y
4600 LLUSER Authority

2008/09/22 13:58:45.661 admin Q1B.ZOS.V Q1B.ZOS.V4600,A Functional Secure+ Admin Added Y
4600 LLUSER Authority

2008/09/22 13:58:45.661  admin Q1B.ZOS.V Q1B.ZOS.V4600,A Functional update_user Deleted Y
4600 LLUSER Authority

2008/09/22 13:58:45.661  admin Q1B.ZOS.V Q1B.ZOS.V4600,A Functional Flush Deleted A
4600 USER Authority

2008/09/22 13:58:45.661 admin Q1B.ZOS.V Q1B.ZOS.V4600,A Functional Refresh Deleted Y
4600 LLUSER Authority

Page 2 of 6 Mon Sep 22 14:56:21 CDT
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Server Status Report
The Server Status report contains system status information about selected managed servers.

The following table describes the report columns:

Column

Description

Server Name

Name of the managed server.

Alerts

Number of active high, medium, and low severity alerts on the server.

Server Version

Version of the server.

License Expire Date

Date that the managed server’s software license expires.

License Type

Type of product license on the server.

License Notification

How many days before a server license expiration date that Sterling Control Center
begins generating license expiration events.

Sessions/ Accounts

Number of concurrent sessions or accounts permitted by the server license.

Max Processes
Permitted/Time Max
Reached

Maximum number of concurrent sessions that have occurred on the server /
Number of times the maximum number of concurrent sessions was reached.

Processes Exec

Number of executing Processes on the server. This is shown for Sterling
Connect:Direct servers only.

Processes Non-Exec

Number of non-executing Processes on the server. This is shown for Sterling
Connect:Direct servers only.

Following is a sample report:

Alerts Server

Server Status Report

License License Sessions / Max Process / Process Process

Server Name (H,Mm,L)  Version Expire Date License Type Notification Accounts Times Reached EXEC NON-EXEC
ccdev02_44_0 000 WINDOWS 4451 01-01-2010 EMERGENCY-KEY 30 0 1
w_winbody44 000 WINDOWS 4451 01-01-2010 EMERGENCY-KEY 30 1/1 1 0
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Server Inventory Report

The Server Inventory Report prints an inventory of the servers monitored and managed by Sterling

Control Center.

Following is a description of the columns that make up the report.

Column

Description

Server Name

The name of the server.

Server Type Type of server (Connect:Direct, Connect:Enterprise, Sterling B2B Integrator, File
Transfer Protocol).
Description Server description.

Server Version

Server platform.

Current Status

The current status of the server.

Monitor This server is monitored by Sterling Control Center. X indicates Yes, blank
indicates No.
Configure This server is configurable by Sterling Control Center. X indicates Yes, blank

indicates No.

License Push

This server supports license push by Sterling Control Center. X indicates Yes,
blank indicates No.

Sterling Connect:Direct
Secure Plus

This server supports Sterling Connect:Direct Secure Plus. X indicates Yes,
blank indicates No.

License Expiration

Expiration date for this server’s current license.

License Type

Type of current license.

License PSP

Software product ID, to uniquely identifies a specific licensed copy of software.
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Following is a sample report:

Server Name  Server Type Description
James-FG Sterling B2B Integrator

pgl-SI_R2 Sterling B2B Integrator

ga-ce-unix Connect:Enterprise

XLIGHT ftp server  File Transfer Protocol
1

ccbuild2-cdwind2  Connect:Direct

augusta Connect:Direct

Page 1of 2

Server Inventory Report

Server
Version

Unknown
Unknown
UNIX 2.4.02
Windows 2003

WINDOWS 4234
UNIX 400090423

Current
Status

Unknown
Unknown
Running
Running

Running

Running

Monitor

x X X X

Confi
gure

License
Push

Secure+ License License Type  License
Expiration PSP
PROD
01-01-2010 EMERGENCY-KEY
1-21-2009 HALT PROD 88888

Thu Jul 23 14:29:40 CDT
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Service Level Criteria Summary Report
The SLC Summary Report lists details regarding each Sterling Control Center SLC.

The following table describes SLC Summary Report columns:

Column Description

SLC Type Standard, Wildcard, or Workflow

ID The name of the SLC.

Enabled Whether or not the SLC is enabled.

Monitoring Window The SLC’s monitoring window parameters.
Matching Properties The matching criteria for items being monitored.
Cal. Sched. The calendar schedule used in setting up the SLC.
Enabled Whether or not the calendar schedule is enabled.
Dur Schedule Duration schedule.

Milestone ID Identifier of the workflow SLC milestone.

Following is a sample report.

SLC Summary Report

Standard Monitoring
D Enabled Window
example true
Matching Properties: nodeld destFile

ccdevo1 bob.txt
Cal.Sched Enabled NSR Start NSR End NER Start NER End NER Day Calendar ID TimeZone
Tuesdays true 06:00 08:00 07:00 09:00 0 Tuesday America/Chicago
Wildcard Monitoring Missing
ID Enabled Window Events
wc example true true
Matching Properties: Name Match Type Value

nodeld Wildcard -

destFile Wildcard bob*.txt
Cal.Sched Enabled NSR Start NSR End NER Start NER End NER Day Calendar ID TimeZone
Tuesdays true 06:00 08:00 07:00 09:00 0 Tuesday America/Chicago
Workflow Concurrence Relative Monitoring Monitoring Suppress
ID Count MS Sched Win.Start Win.End Missing Events MS Messages
Bobolink 1 true 6 6 true false
Milestone ID NSR Start NSR End NER Start NER End DMin DMAX
Milestone A 000:15:00 000:30:00
Matching Properties: Name Match Type Value

nodeld Wildcard Srvr1

Page 1 of 3 Thu Oct 19 15:34:29 CDT
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Database Events Report

The Database Events Report allows you to compose a report of database event data based on the
information that is important to you. You choose the database fields to display and their sort order.
You can also state filter criteria to limit the records to include in the report. Filter criteria include
any of the database fields except for CC Name.

The database fields you can choose from are listed in Events Table (EVENTS) on page 96.

An example follows of a Database Events Report.

Events Report
Date Time Event ID Event Type From Node MSG ID Node ID Node Type
2008/09/23 00:54:25.556 80094354718600658 5 CCNSO00SE jlegel-DT4400 1
2008/09/23 00:54:25.736 80094354718600659 5 CCNSO00SE CDW44.W2003.VM 1
2008/09/23 00:54:25.968 80094354718600660 5 CCNS00SE QIB.ZOS. V4600 1
2008/09/23 00:54:26.265 80094354718600661 5 CCNS00SE QI1G.ZOS. V4700 1
2008/09/23 00:54:26.508 80094354718600662 5 CCNS00SE hpagd000sp 1
2008/09/23 00:54:26.511 80094354718600663 5 CCNSO0101 hpagd000sp 1
2008/09/23 00:54:26.691 80094354718600664 5 CCNS00SE hpigd000sp 1
2008/09/23 00:54:26.694 80094354718600665 5 CCNSO0101 hpigd000sp 1
2008/09/23 00:54:26.818 80094354718600666 5 CCNS005E rhel504000sp 1
2008/09/23 00:54:26.821 80094354718600667 5 CCNS0101 rhel504000sp 1
2008/09/23 00:54:27.064 80094354718600668 10 CCTRO46E CCEngineService 0
2008/09/23 01:54:25.565 80094354718607269 5 CCNSO00SE jlegel-DT4400 1
Page 10f 15 Tue Sep 23 11:08:01 CDT
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Monthly File Transfer Activity Report

The Monthly File Transfer Activity Report lists details regarding monthly file transfer activity on
selected servers.

Following are the columns that make up the Monthly File Transfer Activity Report.

Column Description

Server Name Name of server.

Date Date of file transfer.

Files Sent Number of files sent.

Files Received Number of files received.

File Bytes Number of bytes in files involved in the transfer.
Transmitted Bytes Number of bytes transmitted in the transfer.

Following is a sample report:

Monthly File Transfer Activity Report
Server Name Date Files Sent Files Received File Bytes Transmitted Bytes
qasles10 2008/09 22 22 36,035,121 21,414,195
qasles10 Totals 22 22 36,035,121 21,414,195
qasol10 2008/09 4 4 40,500,000 40,504,800
qgasol10 Totals 4 4 40,500,000 40,504,800
svhppag 2008/09 4 4 40,500,000 40,504,800
svhppag Totals 4 4 40,500,000 40,504,800
All Servers Totals 30 30 117,035,121 102,423,795
1 of
Page tof 2 Wed Sep 24 10:31:08 CDT
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The Users and Roles Summary report is a three-part report that lists the following information:

Users and Roles Summary Report

4+ All Sterling Control Center users and their associated roles
4+ All Sterling Control Center roles and the users assigned to them
4+ All Sterling Control Center roles and their associated permissions

The following table describes the report columns:

Column Description

Part 1

User ID Sterling Control Center user.

User Role Role assigned to the user.

Description Description text provided for the user ID.

Last Login Time

Date and time that the user last logged into Sterling Control Center.

Host The host through which the user last logged in.

IP Address The IP address of the computer on which user last logged in.
Domain The domain of the computer on which user logged in.

Active Whether the user was active when the report was run (Y/N).
Part 2

User Role Roles defined in Sterling Control Center.

Assigned User IDs

User IDs assigned to the role.

Part 3
User Role Roles defined in Sterling Control Center.
Role Authority Server groups and permissions assigned to the role.
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Following is a sample report:

User ID

admin

User Role

superuser

User Role

Flunky

superuser

Users and Roles Summary Report
User Role Description Last Login Time Host
superuser Admin User with Super user Role 10/19/06 2:57 PM GWHITE..sci.local
Assigned User IDs

admin

Role Authority
rules=none
reports=view
actions=view
alerts=view
processes=view
systemSettings=none
slcs=none
roles=none
webAccess=view
users=none
servers=view
rules=manage
reports=manage
actions=manage
alerts=manage
processes=manage
systemSettings=man

sles=manage

Page 1 of 2

IP Address Domain Active

10.251.65.136 SCI Yes

Thu Oct 19 15:18:19 CDT
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Chapter 3

Display the Log Files

You can easily display Sterling Control Center engine trace log files to aid in troubleshooting
installation or other technical support issues. The logs are displayed in read only mode.

To display engine trace log files:
1. Select Tools > Trace Logs.
A list of links displays in your default Internet browser.
2. Select a .log file whose name begins with “CCEngine.”
The log file is displayed in your default text editor application.

Note: If the engine resides on UNIX but you are viewing the trace logs from a Microsoft Windows
system, it is recommended that you right-click, save each log file, and open it using Wordpad.

The logs are displayed in read only mode. This allows users to diagnose issues with the engine
without needing access to the system where the engine is installed.

To display the audit log:
Select Tools > Audit Log.

The Audit Log window displays all objects that have changed. The listing includes the properties
of the object that have changed and when, as well as the values before and after the change. You
can filter this list or save it to disk.
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Chapter 4

Sample Reports in Crystal Reports Format

Sterling Control Center provides the following sample reports in Crystal Reports format.

IR IR R T R S AR

Sterling Connect:Direct Events

Sterling Connect:Direct Exception Trends

Sterling Connect:Direct Exception Trends Chart

Sterling Connect:Direct Usage Report

Sterling Connect:Direct Usage Report Chart

Sterling Connect:Direct Usage by Server Pair Report

Sterling Connect:Direct Usage by Server Pair Report Chart

Sterling Connect:Direct Usage by Server Pair Detail/Summary Report

Note: IBM Sterling does not provide assistance for implementing report solutions in all environments

using all possible third-party tools, including Crystal Reports Viewer. The sample reports provided
in the Sterling Control Center package are designed to act as a starting point for designing your own
reports using the tools of your choice.

Configuring ODBC DSN for the Sample Reports

To use the sample Crystal Reports, you must configure an ODBC DSN as described here.

To perform this procedure, you must already have installed Sterling Control Center with a database.

To configure your computer before using the sample Sterling Control Center reports:

1.
2.

Download and install the ODBC driver for your database type.

After the driver is installed, select Start > Settings > Control Panel > Administrative
Tools > Data Sources (ODBC) to display the ODBC Data Source Administrator window.

Select the System DSN tab.
Click Add.
Select the appropriate driver from the driver list and click Finish.
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Chapter 4 Sample Reports in Crystal Reports Format

6. Type the following information and click OK.

Field Description

Data Source Name  IBMSterling

Type the name in the exact case shown above. Do not type a space between
IBM and Sterling.

Host/Server Name IP address of the Sterling Control Center database (production or staging).

(or IP)

Database name Name of the Sterling Control Center database (production or staging).

User User name to access the Sterling Control Center database (production or
staging).

Password Password to access the Sterling Control Center database (production or
staging).

Port Port number to access the Sterling Control Center database (production or
staging).

Note: The configuration parameters may vary depending on the database type.

Using a Later Version of Crystal Reports for the Sample Reports

Sterling Control Center reports are created using Crystal Reports version 9.0. If you use a later
version of Crystal Reports to generate Sterling Control Center reports, perform the following
procedure to convert the sample reports.

Note: The following procedure is not a substitute for the actual product documentation for Crystal
Reports.

This procedure assumes that you have already connected to the database.

To convert the sample reports using a version of Crystal Reports later than 9.0:
Open a report.

Select Database.

Select Show SQL Query.

Click OK on the Enter Parameter Values window.

Click OK on the Verify Database message.

Click OK on the database is up to date message.

Click Reset, then click OK on the Show SQL Query window.

Save the report under a new name.

© N o a bk~ wbdhPE

The report is saved in the later version of Crystal Reports. Use this report in the future.
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Run the Sterling Control Center Sample Reports

9. Repeat this procedure for each report.

Run the Sterling Control Center Sample Reports

To run the sample reports included with Sterling Control Center:

1. Copy the SampleReports folder from the Sterling Control Center DVD to the desired directory
on your desktop.

Start Crystal Reports.

Select File > Log On/Off Server. The Data Explorer window is displayed.
Expand the ODBC folder.

Select the SterlinglBM ODBC and click Log On.

o M D

Note: Log on to IBMSterling ODBC every time you start Crystal Reports before you run a report.

6. Open a sample report from the SampleReports directory and run it.
7. Select the report criteria and click OK. The report is displayed on your monitor.

Troubleshooting Sterling Control Center Sample Reports

When running the Sterling Control Center sample reports, you may receive a database ODBC error.
If you receive such a message, do the following:

1. Select Database > Show SQL Query from the Crystal Reports menu bar.

2. Select the Show SQL Query tab.

3. Click Reset.

4. Generate the report again.

Sample Reports

The following pages describe the sample reports created by Crystal Reports for Sterling Control
Center. All Crystal Reports sample reports must be printed on 14-inch wide paper.
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Sterling Connect:Direct Events

The Sterling Connect:Direct Event report contains information about events occurring on managed
servers during the specified time period.

The file name for this report is CD_Select_Events.rpt.

The following table lists selection criteria for this report:

Criteria Description

Event Type Sterling Control Center event to show on the report. See the IBM Sterling Control Center
System Administration Guide for a description of event types.

To include an event, select the event from the list box and click Add. You can select
multiple events for the report.

Start Date Start date of the data range.

End Date End date of the data range.

Start Time Start time of the data range. The default is 00:00:00 (midnight).
End Time End time of the data range. The default is 23:59:59.

The following table describes the report columns:

Column Description

Date/Time Date and time that the event was generated.

Node ID Server alias.

Event Type Type of event. See the Sterling Control Center System Administration Guide for a

description of event types.

Alert Indicates if an alert was triggered. The values are:
Blank=No alert
0-3=Alert severity

Alert Deleted By  Sterling Control Center user name of the person who removed the alert.

Rule ID Name of the rule triggered by the event.

Action ID Name of the action called by the rule.

Msg ID Server or Sterling Control Center message ID issued with the event.
Msg Short Text Message short text for the message ID.

Following is a sample report:
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Sterling Connect:Direct Exception Trends

The Sterling Connect:Direct Exception Trends report lists exception counts by category (such as
failed Process steps or Copy steps) during a specified time period. You can specify the report by
month, week, day, or hour. This report is in date/time order.

The file name for this report is CD_Exception_Trends_By_Period.rpt.

The following table lists selection criteria for this report:

Criteria Description

Period Time period that the data is summarized by: monthly, weekly, daily, and hourly.
Start Date Start date of the data range.

End Date End date of the data range.

Start Time Start time of the data range. The default is 00:00:00 (midnight).

End Time End time of the data range. The default is 23:59:59.

The following table describes the report columns:

Column

Description

Processes Total

Total number of Processes (failed and successful) for the specified time period.

Processes Failed

Number of Processes for the specified time period that completed with completion
code greater than 0.

Processes % Failed

Percentage of Processes for the specified time period that completed with
completion code greater than O.

Copy Steps Total

Total number of Copy steps (failed and successful) for the specified time period.

Copy Steps Failed

Number of Copy steps for the specified time period that completed with
completion code greater than O.

Copy Steps % Failed

Percentage of Copy steps for the specified time period that completed with
completion code greater than O.

Run Tasks Total

Total number of Run Task steps (failed and successful) for the specified time
period.

Run Tasks Failed

Number of Run Task steps for the specified time period that completed with
completion code greater than O.

Run Tasks % Failed

Percentage of Run Task steps for the specified time period that completed with
completion code greater than O.

Run Jobs Total

Total number of Run Job steps (failed and successful) for the specified time
period.

Run Jobs Failed

Number of Run Job steps for the specified time period that completed with
completion code greater than O.

IBM Sterling Control Center Reports Guide 76



Column Description

Run Jobs % Failed Percentage of Run Job steps for the specified time period that completed with
completion code greater than O.

Submit Steps Total Total number of Submit steps (failed and successful) for the specified time period.

Submit Steps Failed Number of Submit steps for the specified time period that completed with
completion code greater than O.

Submit Steps % Failed Percentage of Submit steps for the specified time period that completed with
completion code greater than O.

Following is a report sample:
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Sterling Connect:Direct Exception Trends Chart

The Sterling Connect:Direct Exception Trends Chart is nearly identical to Sterling Connect:Direct
Exception Trends on page 76. The only difference is that this report displays the following graphs
on the first page:

4+ Daily total Copy steps (successful and failed)
4+ Daily percentage of failed Copy steps
The file name for this report is CD_Charts_Bar_Copy and PctFail_ByDay.rpt.

The selection criteria and report columns for this report are the same as the Sterling Connect:Direct
Exception Trends report.

Following is a sample report:
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Sterling Connect:Direct Usage Report

The Sterling Connect:Direct Usage Report details Process activity during a specified time period.
You can select to show all Sterling Connect:Direct activity or exception processing only. This
report is in date/time order.

The last page of the report summarizes totals and average run time for Processes, Copy steps, Run
Jobs, Run Tasks, and Submit steps, and file transfer information for the report.

The file name for this report is CD_Usage_and_Exceptions.rpt.

The following table lists selection criteria for this report:

Criteria Description

Exceptions Only (Y/N) Indicates if the report shows all Sterling Connect:Direct activity or exception
processing only.

Start Date Start date of the data range.

End Date End date of the data range.

Start Time Start time of the data range. The default is 00:00:00 (midnight).
End Time End time of the data range. The default is 23:59:59.

The following table describes the report columns:

Column Description

Log Date Time Date and time that the statistics record was written to the log file. Format yyyy/mm/dd
hh:mm:ss.msmsms.

Rec Type Type of statistics record generated. See the Event Type Descriptions topic in the Help
for a list of record IDs.

PNODE Primary node name.

Dir Data transfer or command direction.

==> indicates from the PNODE to the SNODE.
<==indicates from the SNODE to the PNODE.

SNODE Secondary node name.

Proc Name Sterling Connect:Direct Process hame.

Proc Nbr Sterling Connect:Direct Process number.

Step Name Process step.

Duration Amount of time the step took. Format hh:mm:ss.
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Column Description

CC Condition code associated with step termination. Typical codes are:
0=Successful execution.

4=A warning level error was encountered. The statement probably finished normally,
but you should verify the execution results.

8=An error occurred during execution.
16=A catastrophic error occurred during execution.

Msg ID Server or Sterling Control Center message ID issued with the event.

File Name Name of the transferred file. Depending on the step, this can be either the source or
destination file name.

The following columns are displayed on the summary page.

Total Total number (successful and failed) of Processes, Copy steps, Run Job Steps, Run
Task steps, and Submit steps for the specified time period.

Successful Number of Processes, Copy steps, Run Job Steps, Run Task steps, and Submit steps
that completed with a condition code of O for the specified time period.

Failed Number of Processes, Copy steps, Run Job Steps that completed with a condition
code greater than 0 for the specified time period.

% Failed Percent of Processes, Copy steps, Run Job Steps that completed with a condition
code greater than 0 for the specified time period.

Average Time Average time for a Process, Copy step, Run Job Step, Run Task step, and Submit step
for the specified time period. This average includes all successful and failed Processes
and steps.

Bytes Sent Total number of bytes read from source files for the specified time period for all Copy
Steps.

Bytes Received Total number of bytes received by destination files for the specified time period for all
Copy Steps.

Avg Send Rate Average send rate in bytes/second for all Copy Steps.

(Bytes/Sec)

Avg Receive Rate Average receive rate in bytes/second for all Copy Steps.
(Bytes/Sec)

Following is a sample report:
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Sterling Connect:Direct Usage Report Chart

The Sterling Connect:Direct Usage Report Chart is nearly identical to the Sterling Connect:Direct
Usage Report on page 81. The only difference is that the last page of this report displays two pie
charts categorizing usage by step type and failed step type.

You can select to show all Sterling Connect:Direct activity or exception processing only. This
report is in date/time order.

The next-to-last page of the report summarizes totals and average run time for Processes, Copy
steps, Run Jobs, Run Tasks, and Submit steps, and file transfer information for the report.

The file name for this report is CD_Charts_Pie _Usage_and_Exceptions.rpt.

The selection criteria and report columns for this report are the same as for the Sterling
Connect:Direct Usage Report.

Following is a sample report:

IBM Sterling Control Center Reports Guide 84



T2 Jo TZ ofied INVS0:.5:6 TT0Z/TT/90 ‘pad

%000k e L #I00 HEL
%00  pEEsdwSUWAnS#D o wns [ Mm”m _E._U%M_MW_M“”MM WM M”M M

I E Eun 0 wun
MM.M _u_ummmm.mﬂaﬂcsmw no .E_M m L] |E3L Sqoruny ¢ 4o wng [

¢ sdsjgpeaidons@d jo wn OLEE] BEee  (Eelsess=ongel o wng B
%0e9 15PERAden#E jo wns [l 4o08  sdugEoLAdon g 4o wng B
HOGE pEgsassa00d @D bo wns ]

da)g peg Aq sabejuaslad

%00°GE

adA]

adA ]
da)g Aq sabejuasiad

65:65:€¢ TT/90/TTOC 0L

00:00:00 TO/90/TTOC :woid

1oday abesn 10a11Q:108uu0) buiels

85

IBM Sterling Control Center Reports Guide



Sterling Connect:Direct Usage by Server Pair Report

The Sterling Connect:Direct Usage by Server Pair Report summarizes by PNODE-SNODE the type
of activity occurring during a specified time period. This report is in alphabetic PNODE-SNODE
pair order.

You can select to show all Sterling Connect:Direct activity or exception processing only.

You can see the detail for any summary item by double-clicking the item. The detail is identical to
the Sterling Connect:Direct Usage Report on page 81.

The file name for this report is CD_Usage_By_ServerPair_and_Exceptions.rpt.

The following table lists selection criteria for this report:

Criteria Description

Exceptions Only (Y/N) Indicates if the report shows all Sterling Connect:Direct activity or exception
processing only.

Start Date Start date of the data range.

End Date End date of the data range.

Start Time Start time of the data range. The default is 00:00:00 (midnight).
End Time End time of the data range. The default is 23:59:59.

The following table describes the report columns:

Column Description

Total Total number (successful and failed) of Processes, Copy steps, Run Job steps, Run
Task steps, and Submit steps for the indicated PNODE-SNODE combination during
the specified time period.

Failed Number of Processes, Copy steps, Run Job steps, Run Task steps, and Submit steps
that completed with a condition code greater than O for the indicated PNODE-SNODE
combination during the specified time period.

% Failed Percentage of Processes, Copy steps, Run Job steps, Run Task steps, and Submit
steps that completed with a condition code greater than 0 for the indicated
PNODE-SNODE combination during the specified time period.

Average Time Average time for a Process, Copy step, Run Job step, Run Task step, and Submit step
for the indicated PNODE-SNODE combination during the specified time period.

Bytes Sent Total number of bytes read from source files for all Copy Steps on the indicated
PNODE-SNODE combination.

Bytes Received Total number of bytes received by destination files for all Copy Steps on the indicated
PNODE-SNODE combination.

Avg Send Rate Average send rate in bytes/second for all Copy Steps on the indicated
(Bytes/Sec) PNODE-SNODE combination.

Avg Receive Rate Average receive rate in bytes/second for all Copy Steps on the indicated
(Bytes/Sec) PNODE-SNODE combination.
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Column Description

The following columns are displayed on the summary page.

Successful Number of Processes, Copy steps, Run Job Steps, Run Task steps, and Submit steps
that completed with a condition code of O for the specified time period. This information
is not displayed on the exceptions only report.

Failed Number of Processes, Copy steps, Run Job Steps that completed with a condition
code greater than O for the specified time period.

Total Total number (successful and failed) of Processes, Copy steps, Run Job Steps, Run
Task steps, and Submit steps for the specified time period. This information is not
displayed on the exceptions only report.

Average Time Average time for a Process, Copy step, Run Job Step, Run Task step, and Submit step
for the specified time period. This average includes all successful and failed Processes
and steps. This information is not displayed on the exceptions only report.

Bytes Sent Total number of bytes read from source files for the specified time period for all
Processes and Copy Steps. This information is not displayed on the exceptions only
report.

Bytes Received Total number of bytes received by destination files for the specified time period for all
Processes and Copy Steps. This information is not displayed on the exceptions only

report.
Avg Send Rate Average send rate in bytes/second for all Processes and Copy Steps. This information
(Bytes/Sec) is not displayed on the exceptions only report.

Avg Receive Rate Average receive rate in bytes/second for all Processes and Copy Steps. This
(Bytes/Sec) information is not displayed on the exceptions only report.

Following is a sample report:
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Sterling Connect:Direct Usage by Server Pair Report Chart

The Sterling Connect:Direct Usage by Server Pair Report Chart is nearly identical to the Sterling
Connect:Direct Usage by Server Pair Report on page 86. The only difference is that this report
displays the following three usage graphs for each server pair:

4+ Daily Process and Copy steps
4+ Daily failed Process and Copy steps
4+ Daily Copy bytes sent and received

You can select to show all Sterling Connect:Direct activity or exception processing only. This
report is in alphabetic PNODE-SNODE pair order.

The last page of the report summarizes totals and average run time for Processes, Copy steps, Run
Jobs, Run Tasks, and Submit steps, and file transfer information for the report.

The file name for this report is CD_Charts_Line _ServerPair_ByDay.rpt.

The selection criteria and report columns for this report are the same as the Sterling Connect:Direct
Usage by Server Pair Report.

Following is a sample:
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Sterling Connect:Direct Usage by Server Pair Detail/Summary Report

The Sterling Connect:Direct Usage by Server Pair report shows Process activity occurring during a
specified time period by PNODE-SNODE. This report is in alphabetic PNODE-SNODE pair order.

You can specify this report to show detail and summary information or summary information only.
You can also select to show all Sterling Connect:Direct activity or exception processing only.

The last page of the report displays summary report data.
The file name for this report is CD_Usage By _ServerPair_and_Exceptions_Summary_Detail.rpt.

The following table lists selection criteria for this report:

Criteria Description

Exceptions Only (Y/N) Indicates if the report shows all Sterling Connect:Direct activity or exception
processing only.

Summary_Detail (S/D) Indicates if the report shows detail and summary information or only summary

information.
Start Date Start date of the data range.
End Date End date of the data range.
Start Time Start time of the data range. The default is 00:00:00 (midnight).
End Time End time of the data range. The default is 23:59:59.

The following table describes the report columns:

Column Description

The following information is shown only on the detail report.

Log Date Time Date and time that the statistics record was written to the log file. Format yyyy/mm/dd
hh:mm:ss.msmsms.

Dir Data transfer or command direction.
==> indicates from the PNODE to the SNODE.
<==indicates from the SNODE to the PNODE.

Rec Type Type of statistics record generated. See the documentation for the appropriate Sterling
Connect:Direct platform for a list of record IDs.

Proc Name Sterling Connect:Direct Process hame.

Proc Nbr Sterling Connect:Direct Process humber.

Step Name Process step.

Duration Amount of time the step took. Format hh:mm:ss.
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Column

Description

CC

Condition code associated with step termination. Typical codes are:
0=Successful execution.

4=A warning level error was encountered. The statement probably finished normally,
but you should verify the execution results.

8=An error occurred during execution.
16=A catastrophic error occurred during execution.
This report only shows condition codes greater than 0.

Msg ID

Server or Sterling Control Center message ID issued with the event.

File Name

Name of the transferred file. Depending on the step, this can be either the source or
destination file name.

The following columns are displayed on the summary report and the last page of the detail report.

Successful Number of Processes, Copy steps, Run Job Steps, Run Task steps, and Submit steps
that completed with a condition code of O for the specified time period. This information
is not displayed on the exceptions only report.

Failed Number of Processes, Copy steps, Run Job Steps that completed with a condition
code greater than 0 for the specified time period.

Total Total number (successful and failed) of Processes, Copy steps, Run Job Steps, Run

Task steps, and Submit steps for the specified time period. This information is not
displayed on the exceptions only report.

Average Time

Average time for a Process, Copy step, Run Job Step, Run Task step, and Submit step
for the specified time period. This average includes all successful and failed Processes
and steps. This information is not displayed on the exceptions only report.

Bytes Sent

Total number of bytes read from source files for the specified time period for all
Processes and Copy Steps. This information is not displayed on the exceptions only
report.

Bytes Received

Total number of bytes received by destination files for the specified time period for all
Processes and Copy Steps. This information is not displayed on the exceptions only
report.

Avg Send Rate
(Bytes/Sec)

Average send rate in bytes/second for all Processes and Copy Steps. This information
is not displayed on the exceptions only report.

Avg Receive Rate
(Bytes/Sec)

Average receive rate in bytes/second for all Processes and Copy Steps. This
information is not displayed on the exceptions only report.

Following is a sample report:
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Chapter 5

Data for Third-Party Reporting Tools

Data for third-party reporting tools is contained in Sterling Control Center tables. The following
tables are discussed here:

4+ Events Table (EVENTS)

4+ Events Extension Table (EVENTS_EXT)

4+ Event Comments Table (EVENT_COMMENTS)

4+ Sterling Connect:Direct Statistics Table (CD_STATS_LOG)
4+ Sterling Connect:Direct Statistics Table By Record ID

4+ Sterling Connect:Enterprise Statistics Table (CE_STATS_LOG)
4+ Event Type Table (EVENT_TYPE)

4+ Node Type Table (NODE_TYPE)

4 Pair Connections Table (PAIR_CONN)

4+ Discovery Node Table (DISCOVERY_NODE)

4+ Metadata Labels Table (META_DATA_LABELS)

4+ Sterling Control Center Internal Tables

Note: Some fields use a Java epoch timestamp as a unique value. This timestamp is the number of
milliseconds that have elapsed since January 1, 1970.
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Events Table (EVENTYS)

The following table describes the data fields available from the Events table for Sterling Control

Center reports.

Element

Type

Description

ACTION_ID

varchar

Name of an action called by a rule.

ACTIONS_COMPLETED

bigint

Indicates if the Sterling Control Center actions are completed. The
values are:

Null=Actions not completed
Timestamp=Actions completed
This element is used for restarts.

ALERT

char

Indicates if an alert was triggered. The values are:
Null=No alert
0-3=Alert severity

ALERT_DELETED

char

Indicates if the alert was deleted. The values are:
Null=Alert not deleted
Y=Alert deleted

ALERT_DELETED_BY

varchar

Sterling Control Center user name of the person who removed the
alert. If the alert was deleted by a rule, this field will contain
“unknown.”

ALERT_DESC

varchar

Comments entered by the user when the alert was deleted.

ALERT_UPD_TIME

bigint

Time that the alert was updated, in Java epoch timestamp format
(that is, the number of milliseconds that have elapsed since
January 1, 1970).

DATE_TIME

varchar

Date and time that the event was generated. Format yyyy/mm/dd
hh:mm:ss.msmsms.

DEST_FILE

varchar

Destination file name in a copy operation.

EMAIL_FLAG

bigint

This field is used by Sterling Control Center for recover purposes.
When a rule matches an event, the associated action is executed.
If the action includes sending an e-mail, this flag updates after the
e-mail is sent. Reporting on this field is not recommended. The
values are:

0=No e-mail sent
>0=E-mail sent

The value is set to zero if nothing was done, but is set to the
Timestamp if something was done.

EVENT_ID

bigint

ID number assigned by the system to each event.
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Events Table (EVENTS)

Element Type Description

EVENT_TYPE bigint Code indicating the type of event. See Event Type Table
(EVENT_TYPE) on page 116 for a listing of event types and
descriptions.

FILE_SIZE bigint Size of the file transferred by the Sterling Connect:Direct Process
or Sterling Connect:Enterprise batch.

FROM_NODE varchar  Server that sent the file.
P=Pnode was sending server.
S=Snode was sending server.

MSG_ID varchar  Server or Sterling Control Center message ID issued with the
event.

NODE_ID varchar  Server name of alias.

NODE_TYPE varchar  Code indicating the type of server. The server types are:
0=Sterling Control Center
1=Connect:Direct
2=Connect:Enterprise
3=Sterling B2B Integrator
4=FTP Server

ORIG_NODE varchar  The server that initiated the Process.

PART_KEY date The date the event was generated. The format is yyyy-mm-dd.

PERCENT_COMPLETE bigint Percentage of a Sterling Connect:Direct Copy Process that is
complete.

PROC_ID varchar  Sterling Connect:Direct Process or Sterling Connect:Enterprise
batch number.

PROC_NAME varchar  Sterling Connect:Direct Process hame or Sterling
Connect:Enterprise batch name.

REMOTE_NODE varchar  Name of the remote server involved in the Process or file transfer.

RET_CODE varchar  Specifies a numeric code returned from a completed Process or file
transfer that indicates failure or success. The standard return
codes are:
0=Successful completion
4=Warning
8=Error
16=Catastrophic error

RULE_ID varchar  Name of the rule triggered by the event.

RULE_INSTANCE_ID bigint Unique identifier for rule matching instances

SEQ_NUM bigint A number used to uniquely identify events generated at the same
time.

SHORT_MSG varchar  Message text associated with the Message ID.
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Element Type Description

SLC_FLAG bigint Internally used by Sterling Control Center for recovery purposes.
When an event is generated, it is sent to the SLC subsystem. This
flag indicates whether or not the event has been sent to that
subsystem. Reporting on this field is not recommended. The values
are:
0O=Event was not sent
>0=Event was sent

SLC_ID text System-assigned name for each SLC window.

SLC_INSTANCE_ID bigint Unique identifier for each SLC window.

SLC_SOURCE_1 text Internal field used for SLC recovery.

SLC_SOURCE_2 text Internal field used for SLC recovery.

SLC_SRC_EVENT_ID bigint EVENT_ID of the event that triggered the SLC.

SOURCE_FILE varchar  Source file name in a copy.

STEP_NAME varchar  Name of the Sterling Connect:Direct Process step.

SUBMITTER varchar  User ID of the Process submitter.

TRAP_FLAG bigint Internally used by Sterling Control Center for recovery purposes.
When a rule matches an event, the associated action is executed.
If the action includes sending an SNMP trap, this flag updates after
the SNMP trap is sent. Reporting on this field is not recommended.
The values are:
0=No trap generated
>0=Trap generated
The value is set to zero if nothing was done, but is set to the
Timestamp if something was done.

USER_DATA 1 varchar  User metadata field 1.

USER_DATA 2 varchar  User metadata field 2.

USER_DATA_3 varchar  User metadata field 3.

USER_DATA 4 varchar  User metadata field 4.

SERVER_DATA 1 varchar  Server metadata field 1.

SERVER_DATA 2 varchar  Server metadata field 2.

SERVER_DATA 3 varchar  Server metadata field 3.

SERVER_DATA 4 varchar  Server metadata field 4.

SERVER_DATA 5 varchar  Server metadata field 5.

SERVER_DATA_6 varchar  Server metadata field 6.

SERVER_DATA 7 varchar  Server metadata field 7.

SERVER_DATA 8 varchar  Server metadata field 8.
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Events Table (EVENTS)

Element

Type

Description

SERVER_DATA_9

varchar

Server metadata field 9.

SERVER_DATA_10

varchar

Server metadata field 10.

USER_OP_FLAG

bigint

Internally used by Sterling Control Center for recovery purposes.
When a rule matches an event, the associated action is executed.
If the action includes invoking an OS command script, this flag is
updated after invoking the OS command script. Reporting on this
field is not recommended. The values are:

0=No OS command invoked
>0=0S command invoked

The value is set to zero if nothing was done, but is set to the
Timestamp if something was done.

XML_STRING

text

An XML representation of the event.
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Events Extension Table (EVENTS_EXT)

The Events Extension (EVENTS_EXT) database table is used when an event triggers one or more
Data Visibility Group (DVG) rules. For each DVG rule an event triggers, a supplemental entry, or
row, is inserted into the EVENTS_EXT table and the EVENT _ID value is used to join the
information in the two tables.

The following table describes the data fields available from the EVENTS_EXT table for Sterling
Control Center reports.

Element Type Description

ACTION_ID varchar  Name of an action called by a rule.

ACTIONS_COMPLETED  bigint Indicates if the Sterling Control Center actions are completed. The
values are:

Null=Actions not completed
Timestamp=Actions completed
This element is used for restarts.

ALERT char Indicates if an alert was triggered. The values are:
Null=No alert
0-3=Alert severity

ALERT_DELETED char Indicates if the alert was deleted. The values are:
Null=Alert not deleted
Y=Alert deleted

ALERT_DELETED_BY varchar  Sterling Control Center user name of the person who removed the
alert. If the alert was deleted by a rule, this field will contain
“unknown.”

ALERT_UPD_TIME bigint Time that the alert was updated, in Java epoch timestamp format

(that is, the number of milliseconds that have elapsed since
January 1, 1970).

DATE_TIME varchar  Date and time that the event was generated. Format yyyy/mm/dd
hh:mm:ss.msmsms.

DVG varchar  Data visibility group for this event.

EMAIL_FLAG bigint This field is used by Sterling Control Center for recovery purposes.

When a rule matches an event, the associated action is executed.
If the action includes sending an e-mail, this flag updates after the
e-mail is sent. Reporting on this field is not recommended. The
values are:

0=No e-mail sent
>0=E-mail sent

The value is set to zero if nothing was done, but is set to the
Timestamp if something was done.

IBM Sterling Control Center Reports Guide 100



Events Extension Table (EVENTS_EXT)

Element Type

Description

EVENT_ID bigint

ID number assigned by the system to each event. The EVENT_ID
value can be used to find additional information associated with
this event in the Events database table.

PART_KEY date

The date the event was generated. The format is yyyy-mm-dd.

RULE_ID varchar

Name of the rule triggered by the event.

RULE_INSTANCE_ID bigint

Unique identifier for rule matching instances

TRAP_FLAG bigint

Internally used by Sterling Control Center for recovery purposes.
When a rule matches an event, the associated action is executed.
If the action includes sending an SNMP trap, this flag updates after
the SNMP trap is sent. Reporting on this field is not recommended.
The values are:

0=No trap generated
>0=Trap generated

The value is set to zero if nothing was done, but is set to the
Timestamp if something was done.

USER_OP_FLAG bigint

Internally used by Sterling Control Center for recovery purposes.
When a rule matches an event, the associated action is executed.
If the action includes invoking an OS command script, this flag is
updated after invoking the OS command script. Reporting on this
field is not recommended. The values are:

0=No OS command invoked
>0=0S command invoked

The value is set to zero if nothing was done, but is set to the
Timestamp if something was done.
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Event Comments Table (EVENT_COMMENTS)

The Event Comments Table stores comment information on alerts when those alerts are deleted. In
earlier versions of Sterling Control Center these comments were part of the Events table.

The following table describes the data fields in the Event Comments table for Sterling Control
Center reports:

Element Type Description

DATE_TIME varchar  The event date and time.

EVENT_COMMENT text Textual comment describing the event’s deletion.

EVENT_ID bigint The identifier for the specific event.

PART_KEY date The date the event was generated. The format is yyyy-mm-dd.
USER_ID varchar  The identifier of the Sterling Control Center user entering the

comment and deleting the event.
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Sterling Connect:Direct Statistics Table (CD_STATS LOG)

The following table describes the data fields available from the Sterling Connect:Direct Statistics
(CD_STATS_LOG) table for Sterling Control Center reports:

Element Type Description

ALIAS_ MEMBER_NAME varchar PDS alias member name.

BYTES_READ bigint Number of bytes read from the source file.
BYTES_RECEIVED bigint Number of bytes received by the destination file.
BYTES_SENT bigint Number of bytes sent to the destination file.
BYTES_WRITTEN bigint Number of bytes written to the destination file.
CB_ENC_ALG varchar Specifies the name of the encryption algorithm.
CERT_ISSUER text Issuer value from certificate used.
CERT_SUBJECT text Subject name value from certificate used.
CHECK_POINT varchar Indicates if Checkpoint is activated for this Process.

Y=Checkpoint is activated
N=Checkpoint is not activated

CIPHER_SUITE text Name of cipher suite used.

CLASS varchar Determines the server-to-server session on which a Process can
be executed.

COND_CODE varchar Return code associated with step termination. Typical codes are:
0=Successful execution.

4=A warning level error was encountered. The statement
probably finished normally, but you should verify the execution
results.

8=An error occurred during execution.
16=A catastrophic error occurred during execution.

Note: This column is not populated in this table since it is
duplicated in the Events table.

DEBUG varchar For Sterling Connect:Direct for z/OS, the DEBUG setting within
the Process.

DEST_DISP_1 varchar What to do with the destination file after a copy is complete. The
values are:

NEW=Creates a new file on the destination node.

RPL=Creates a new file on the destination node or, if the file
already exists, replaces the named file on the destination node.

MOD=Appends data to the end of an existing file for which you
have exclusive rights.
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Element Type Description
DEST_DISP_2 varchar Disposition of the destination file after a normal Process step
termination. The values are:
C=Catalog
K=Keep
DEST_DISP_3 varchar Disposition of the destination file after an abnormal Process step
termination.
C=Catalog
D=Delete
K=Keep
DEST_FILE varchar Destination file name.
Note: This column is not populated in this table since it is
duplicated in the Events table.
EVENT_ID bigint ID number assigned by the system to each event.
EXEC_PRIORITY varchar Priority under which the operating system thread that executes
Sterling Connect:Direct runs. Applies to Microsoft Windows only.
EXT_COMPRESSION varchar Extended compression option.
Y=Extended compression is activated
N=Extended compression is not activated
FEED_BACK varchar Feedback code for the module. The value depends on the
module that creates it. Your Sterling Connect:Direct Customer
Support representative may ask you for this value.
FROM_NODE varchar Node that sent the file. The values are:
S=SNODE
P=PNODE
Note: This column is not populated in this table since it is
duplicated in the Events table.
FUNCTION_INFO varchar Specifies the function being performed.
HOLD varchar Hold status of a Process. The Hold statuses are:
No=The Process is not placed in the Hold queue. It is executed
as soon as resources are available.
Yes=The Process is held in the Hold queue in Held Initially (HI)
status until it is explicitly released.
Call=The Process is held until the SNODE, as specified in the
Process SNODE parameter, connects to the PNODE. The
Process is then released for execution. The Process is also
released when another Process on the PNODE connects to the
SNODE.
LINK_FAIL varchar Indicated whether a link failure occurred during transmission.

¢ Link fail occurred

¢ Link fail did not occur
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Sterling Connect:Direct Statistics Table (CD_STATS_LOG)

Element Type Description
LOCAL_COND_CODE varchar Condition (return) code produced by the local server. See
COND_CODE on page 103 for typical return codes.
LOCAL_MSG_ID varchar Specifies the message ID produced by the local server.
LOCAL_NODE varchar Server that processed the file.
S=SNODE
P=PNODE
LOG_DATE_TIME varchar Date and time that the statistics record was written to the log file.
Format yyyy/mm/dd hh:mm:ss.msmsms.
MEMBER_NAME varchar Name of the member copied.
MERGE_EA varchar Specifies the merged data encryption algorithm resulting from the
merger of the PNODE and SNODE encryption algorithms.
MERGE_SIGN varchar Specifies the merged results from the digital signature settings for
the PNODE and SNODE. If digital signature is enabled for either
the PNODE or the SNODE, then digital signatures are used for
the session. If digital signatures are not enabled for both the
PNODE and SNODE, digital signatures are not used.
MSG_ID varchar Server or Sterling Control Center message ID issued with the
event.
Note: This column is not populated in this table since it is
duplicated in the Events table.
MSG_SHORT_TXT varchar Message short text.
Note: This column is not populated in this table since it is
duplicated in the Events table.
NODE_ID varchar Server alias.
Note: This column is not populated in this table since it is
duplicated in the Events table.
NODE_NAME varchar Name of the Sterling Connect:Direct server.
NODE_TYPE varchar Code indicating the type of server.
Note: This column is not populated in this table since it is
duplicated in the Events table.
OTHER_COND_CODE varchar Condition (return) code produced by the other (remote) server.
See COND_CODE on page 103 for typical return codes.
OTHER_MSG_ID varchar Specifies the message ID produced by the other (remote) server.
PART_KEY date The date the statistics record was written to the log file. The
format is yyyy-mm-dd.
PNODE varchar Primary node name.
Note: This column is not populated in this table since it is
duplicated in the Events table.
PNODE_ACCT_INFO varchar PNODE accounting information.
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Element Type Description

PNODE_ENC_ALG_LIST varchar Data encryption algorithm used on the PNODE.

PNODE_ENC_DATA varchar PNODE encryption data.

PNODE_PLEX_CLASS varchar PLEXCLASS of the PNODE.

PNODE_SIGN varchar Specifies if digital signatures are enabled for the PNODE.

PREV_SIGN_VERIFIED varchar Specifies if the previous encryption key was used for verifying the
digital signature.

PRIORITY varchar Specifies the priority assigned to the Process. The lower the
number the higher the priority.

PROC_NAME varchar Sterling Connect:Direct Process name.
Note: This column is not populated in this table since it is

duplicated in the Events table.

PROC_NUMBER varchar Sterling Connect:Direct Process number.

Note: This column is not populated in this table since it is
duplicated in the Events table.

QUEUE varchar Specifies the queue containing the Process. The queues are:
Execution=Processes currently being executed.
Hold=Processes that are either held by the user or operator or
held due to execution errors.
Timer=Processes that are scheduled to be executed later, or
Processes in time retry due to session errors.
Wait=Processes that are eligible for execution and are awaiting
selection.

RECORD_CATEGORY varchar Specifies whether the record is related to an event or to a
Process. The values are:
CAEV=The record is related to a Sterling Connect:Direct event,
such as a Sterling Connect:Direct shutdown.
CAPR=The record is related to a Sterling Connect:Direct
Process.

RECORD_ID varchar Type of statistics record generated. See the Event Type
Descriptions Help topic for a list of record IDs.

RECORDS_READ bigint Specifies the number of records read from the source file.

RECORDS_WRITTEN bigint Specifies the number of records written to the destination file.

RESTART varchar Indicates if Restart is activated for the Process.

Y=Restart was activated
N=Restart was not activated
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Sterling Connect:Direct Statistics Table (CD_STATS_LOG)

Element Type Description

RETAIN varchar Indicates whether Sterling Connect:Direct retains a copy of a
Process after it is executed. The Retain options are:
Initial=Specifies to retain the Process in the Hold queue for
execution every time that Sterling Connect:Direct initializes.
No=Specifies not to retain the Process after it is executed.
Yes=Specifies to retain the Process in the Hold queue after it is
executed. You can release the Process for execution later or
delete it.

RU_SIZE varchar Specifies the size of buffers received by the destination file.

RUS_RECEIVED bigint Specifies the number of buffers received by the destination file.

RUS_SENT bigint Specifies the number of buffers sent to the destination file.

SCH_DATE_TIME varchar Specifies the date and time that a Process is scheduled to
execute. Format yyyy/mm/dd hh:mm:ss.msmsms.

SECURE_ENABLED varchar Indicates that Sterling Connect:Direct Secure Plus is activated for

the Process.

SECURE_PROTOCOL text

Name of protocol used for secure connection.

SEQ_NUM bigint System-assigned sequence number.
Note: This column is not populated in this table since it is
duplicated in the Events table.
SERVER_NAME varchar Sterling Connect:Direct/Plex server name.
SNODE varchar Secondary node name.
Note: This column is not populated in this table since it is
duplicated in the Events table.
SNODE_ACCT_INFO varchar Specifies SNODE accounting information.

SNODE_ENC_ALG_LIST varchar

Data encryption algorithm used on the SNODE.

SNODE_ENC_DATA varchar

SNODE encryption data.

SNODE_PLEX_CLASS varchar

PLEXCLASS of the SNODE.

SNODE_SIGN varchar Specifies if digital signatures are enabled for the SNODE.

SOURCE_MEMBER_NA varchar Source file member name.

ME

SRC_DISP_1 varchar Specifies access to the source file during a copy operation. The
source disposition values are:
SHR=The file can be opened by another Process for read-only
access while it is being copied.
OLD=The file cannot be opened by another Process during the
transfer.

SRC_DISP_2 varchar Disposition of the source file after a successful Process step

termination.
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Element

Type

Description

SRC_DISP_3

varchar

Disposition of the source file after an abnormal Process step
termination.

SRC_FILE

varchar

Source file name.

Note: This column is not populated in this table since it is
duplicated in the Events table.

START_TIME

varchar

Process start time.

STATUS

varchar

Specifies the Process status. The statuses are:
Execution (EX)=The Process is executing.

Pending Execution (PE)=The Process is selected for execution
and startup is in progress.

Waiting Connection (WC)=The Process is ready to execute, but
all available connections to the SNODE are in use.

Waiting Start Time (WS)=The Process is waiting in the Timer
gueue because it was submitted with a start time or date that has
not expired. When the start time is reached, the Process is placed
into the Wait queue for scheduling for execution.

Held Suspension (HS)=The operator issued a delete Process
request with Hold set to Yes.

Timer Retry (RE)=A Process error occurred and the Process was
moved to the Timer queue in RE status with short-term and
long-term wait times beginning.

Held for Call (HC)=The Process was submitted with the Hold
parameter set to Call. A session started from either node moves
the Process to the Wait queue in WC status. The Process is
placed in the Execution queue when it is selected for execution.

Held Due to Error (HE)=A session error or other abnormal
condition occurred.

Held Initially (HI)=The Process was submitted with the Hold
option set to Yes.

Held By Operator (HO)=A change Process request with Hold set
to Yes was issued.

Held By Retain (HR)=The Process was submitted with retain after
execution set to Yes or Initial.

STD_COMPRESSION

varchar

Standard compression option.
Y=Standard compression is activated
N=Standard compression is not activated

STEP_NAME

varchar

Process step name.

Note: This column is not populated in this table since it is
duplicated in the Events table.

STOP_TIME

varchar

Process stop time.

SUB_DATE_TIME

varchar

Date and time that the Process was submitted. Format
yyyy/mm/dd hh:mm:ss.msmsms.

SUBMIT_NODE

varchar

Server where the submit operation was performed.
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Sterling Connect:Direct Statistics Table (CD_STATS_LOG)

Element Type Description
SUBMITER varchar User ID that submitted the Process.
Note: This column is not populated in this table since it is
duplicated in the Events table.
SUBMITTER_NODE varchar Server that submitted the Process.
SUR_SIGN_VERIFIED varchar Specifies if the current encryption key was used for verifying the
digital signature.
SYS_OPTS varchar Specifies the platform-specific system operations.
TARGET_MEMBER_NA  varchar Destination target member name.
ME
TRANSLATION varchar Specifies if the data was translated.
Y=Data was translated
N=Data was not translated
USER_DATA 1 varchar Metadata field 1.
Note: This column is not populated in this table since it is
duplicated in the Events table.
USER_DATA 2 varchar Metadata field 2.
Note: This column is not populated in this table since it is
duplicated in the Events table.
USER_DATA_3 varchar Metadata field 3.
Note: This column is not populated in this table since it is
duplicated in the Events table.
USER_DATA 4 varchar Metadata field 4.

Note: This column is not populated in this table since it is
duplicated in the Events table.
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Sterling Connect:Direct Statistics Table By Record ID

The following table shows the columns filled in for each Record ID in the Virtual Sterling
Connect:Direct Statistics Table (V_CD_STATS_LOG). These record IDs are for Sterling
Connect:Direct for z/OS only.

Record ID Sl CH QE SB Pl Zl Cl CT PT ZT

ALIAS_MEMBER_NAME

BYTES_READ

BYTES_SENT

CERT_ISSUER X

CERT_SUBJECT X

CHECK_POINT

CIPHER_SUITE X

COND_CODE X X X X X X

DEST DISP_1

DEST_DISP_2

DEST_DISP_3

DEST_FILE

EVENT_ID X X X X X X X

FEED_BACK

FROM_NODE X

LOCAL_NODE

LOG_DATE_TIME X X X X X X X

MEMBER_NAME X

MSG_ID

MSG_SHORT_TXT

NODE_ID

NODE_NAME

X | X | X | X | X
X | X | X | X | X
x
x
x
x
x
X | X | X | X | X
X | X | X | X | X

NODE_TYPE

X | X | X[ X[ X| X[ X|X| X[ X|X|X|X|X|X|X|X|X|X|X|X]|X|X
x
x

OTHER_COND_CODE
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Sterling Connect:Direct Statistics Table By Record ID

Record ID

Sl

CH

QE

SB PI VAl Cl

CT PT

ZT MC

OTHER_MSG_ID

PNODE

PNODE_ACCT_INFO

PNODE_ENC_ALG_LIST

PNODE_PLEX_CLASS

PNODE_SIGN

PRIORITY

PROC_NAME

PROC_NUMBER

x
x

QUEUE

RECORD_ID

X | X | X | X

RECORDS_READ

RESTART

RETAIN

RU_SIZE

RUS_RECEIVED

RUS_SENT

X | X | X | X| X| X]| X
x

SCH_DATE_TIME

SECURE_ENABLED

SECURE_PROTOCOL

SEQ_NUM

SERVER_NAME

SNODE

X | X | X | X | X
x
x
x

SNODE_ACCT_INFO

X | X | X | X| X| X

SNODE_ENC_ALG_LIST

SNODE_PLEX_CLASS

SNODE_SIGN

SOURCE_MEMBER_NAME

SRC_DISP_1

SRC_DISP_2

SRC_DISP_3
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Record ID Sl CH QE SB Pl VA Cl CT PT ZT MC
SRC_FILE X X

START_TIME X X X X X X X X X
STATUS X

STD_COMPRESSION X

STEP_NAME X X X

STOP_TIME X X
SUB_DATE_TIME X X X X
SUBMIT_NODE X X X X X X X X X
SUBMITER X X X X X X X X X
TARGET_MEMBER_NAME X X X
USER_DATA_1 X X X X X X X X X X X
USER_DATA 2 X X X X X X X X X X X
USER_DATA_3 X X X X X X X X X X X
USER_DATA 4 X X X X X X X X X X X
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Sterling Connect:Enterprise Statistics Table
(CE_STATS_LOG)

The following table describes the data fields available from the Sterling Connect:Enterprise
Statistics (CE_STATS_LOG) table for Sterling Control Center reports:

Element Type Description
APPL_AGENT_TYPE varchar Specifies one of the following application agent types:
¢ Console

¢ End Of Batch
¢ logging
¢ Scheduler

¢ Wake Up Terminate

BATCH_ID varchar User-assigned description of a Sterling Connect:Enterprise
batch.

Note: This column is not populated in this table since it is
duplicated in the Events table.

BATCH_NUMBER varchar System-assigned number for each batch in a Sterling
Connect:Enterprise repository.

Note: This column is not populated in this table since it is
duplicated in the Events table.

BYTES_READ bigint Number of bytes read from the source file.
BYTES_WRITTEN bigint Number of bytes written to the destination file.
DEST_FILE varchar Destination file name.

Note: This column is not populated in this table since it is
duplicated in the Events table.

EVENT_ID bigint ID number assigned by the system to each event.

JOB_ID varchar Batch job identifier.

JOB_NAME varchar Name of the job that added the batch.

LINE_NAME varchar Line accessed during Auto and Remote Connects.
LIST_NAME varchar Sterling Connect:Enterprise Auto Connect List Name. The Auto

Connect List defines the remote sites that the Sterling
Connect:Enterprise server automatically connects to and
transmits batches to.

LOG_DATE_TIME varchar Date and time that the statistics record was written to the log file.
Format yyyy/mm/dd hh:mm:ss.msmsms.
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Element Type Description

MAILBOX_FLAGS varchar Sterling Connect:Enterprise batch status flag. See the
appropriate Sterling Connect:Enterprise documentation for a list
of batch status flags.

MAILBOX_ID varchar Specifies the repository associated with the Sterling
Connect:Enterprise batch

MSG_ID varchar Server or Sterling Control Center message ID issued with the
event.

Note: This column is not populated in this table since it is
duplicated in the Events table.

MSG_SHORT_TXT varchar Message short text.

Note: This column is not populated in this table since it is
duplicated in the Events table.

NODE_ID varchar Server alias.

Note: This column is not populated in this table since it is
duplicated in the Events table.

NODE_NAME varchar Name of the Sterling Connect:Direct server.

NODE_TYPE varchar Code indicating the type of server.

Note: This column is not populated in this table since it is
duplicated in the Events table.

(e]]n} varchar Object identifier that identifies the Sterling Connect:Enterprise
SNMP trap received by the engine.

PART_KEY date The date the statistics record was written to the log file.
The format is yyyy-mm-dd.

PROTOCOL varchar Protocol used for the file transfer.

RECIP_MAILBOX_ID varchar Sterling Connect:Enterprise Mailbox ID of the repository that

received the batch.

RECORD_CATEGORY varchar One of the following connection types:
AC=Auto Connect
RC=Remote Connect

RECORD_ID varchar Type of statistics record generated. See the Event Type
Descriptions Help topic for a list of record IDs.

REL_SELECT_STMT varchar Position of the Sterling Connect:Enterprise SELECT statement
that executed the rule which caused an SNMP trap to be
generated.

REMOTE_NAME varchar Name of the remote server involved in the file transfer.

RULE_MEMBER_NAME varchar Data set member name that contains the application agent rules.

RULE_NAME varchar Name of the Sterling Connect:Enterprise application agent rule.
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Sterling Connect:Enterprise Statistics Table (CE_STATS_LOG)

Element Type Description

SEQ_NUM bigint System-assigned sequence number.

Note: This column is not populated in this table since it is
duplicated in the Events table.

SESSION_ID varchar System-assigned ID identifying a connection between a Sterling
Connect:Enterprise host and a remote site.

SRC_FILE varchar Source file name.

Note: This column is not populated in this table since it is
duplicated in the Events table.

START_TIME varchar Time that start-of-batch transmission information is received by
the Sterling Control Center engine.

STATUS varchar FTP session status (active or inactive).

Note: This column is not populated in this table since it is
duplicated in the Events table.

STOP_TIME varchar Time that end-of-batch transmission information is received by
the Sterling Control Center engine.

TIME_UP varchar Length of time that the Sterling Connect:Enterprise server has
been running.

USER_DATA 1 varchar Metadata field 1.

Note: This column is not populated in this table since it is
duplicated in the Events table.

USER_DATA 2 varchar Metadata field 2.

Note: This column is not populated in this table since it is
duplicated in the Events table.

USER_DATA 3 varchar Metadata field 3.

Note: This column is not populated in this table since it is
duplicated in the Events table.

USER_DATA 4 varchar Metadata field 4.

Note: This column is not populated in this table since it is
duplicated in the Events table.

WKFLOW_ID varchar Sterling B2B Integrator ID, if Sterling B2B Integrator requested a
file transfer from a Sterling Connect:Enterprise for UNIX server.

WRKFLOW_URL varchar Sterling B2B Integrator URL, if Sterling B2B Integrator requested
a file transfer from a Sterling Connect:Enterprise for UNIX
server.
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Event Type Table (EVENT_TYPE)

The Event Type table contains a listing of Sterling Control Center event types and descriptions.

Element Type Description
EVENT_TYPE bigint Code indicating the type of event.
EVENT_TYPE_DESCR varchar Description of the event type codes. The codes and

descriptions are:

1=Process Step Started

2=Process Step Ended

3=Process Started

4=Process Ended

5=Server Status

6=SLC Notification

7=Server Shutdown Started (for future use)
8=Server Shutdown (for future use)

9=Process Status

10=Server license

11=Server Error

12=Server Command

13=Connection Started

14=Connection Shutdown Started (for future use)
15=Sterling Control Center Status (for future use)
16=Process Queue

17=Process Interrupted

66=Suppressed SLC Noatification
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Node Type Table (NODE_TYPE)

The Node Type table contains a listing of node (server) types monitored by Sterling Control Center.

Element Type Description

NODE_TYPE bigint Code indicating the type of event.

NODE_TYPE_DESCR varchar Type of server. The server types are:
O=Sterling Control Center
1=Connect:Direct
2=Connect:Enterprise
3=Sterling B2B Integrator
4=FTP
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Pair Connections Table (PAIR_CONN)

The following table describes the data fields available from the Node Discovery Pair Connections
Table for Sterling Control Center reports.

Element Type Description

DISCOVERED_ID bigint Reference to Discovery Node table.
DISCOVERY_START_TM varchar Discovery start date range value.
DISCOVERY_STOP_TM varchar Discovery end date range value.
EXPLORER_ID bigint Reference to Discovery Node table.
FROM_NETMAP smallint 1=Found in Netmap

0=Not found in Netmap

FROM_STATS smallint 1=Found in statistics
0=Not found in statistics

LAST_CONN_D2E varchar Last connection time found from
Discovered to Explorer node.

LAST_CONN_E2D varchar Last connection time found from
Explorer to Discovered node.

TIMES_CONN_D2E bigint Number of connections initiated by
Discovered node to Explorer node.

TIMES_CONN_E2D bigint Number of connections initiated by
Explorer node to Discovered node.
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Discovery Node Table (DISCOVERY_NODE)

The following table describes the data fields in the Discovery Node Table.

Element Type Description
ANOS400 smallint 0=Node is not OS/400.

1=Node is OS/400.
API_PORT varchar API port value.
COMMENTS text User description for node.
CONNECTION_TIMEOUT bigint Internal field used for Node Discovery.
DB_LIBRARY varchar Sterling Connect:Direct for i5/0S database library name.
DISCOVERED_TIME varchar Time node was discovered.
DISCOVERY_START_TM varchar Discovery start date range value.
DISCOVERY_STOP_TM varchar Discovery end date range value.
DTF_ADDRESS varchar Server host address.
DTF_PORT varchar Server port value.
ENABLED smallint 0=Disabled

1=Enabled
FROM_NETMAP smallint 0=Not found in Netmap.

1=Found in Netmap.
FROM_STATS smallint 0=Not found in statistics.

1=Found in statistics.
HOST_NAME varchar Host name for server.
ID bigint For internal use.
IGNORED smallint For discovered nodes:

1=Found in Mylist.

0=Found in Discovered list.
LAST_DSCVRY_ATTEMPT varchar Time of last discovery attempt.
LST_SCCSSFL_DSCVRY varchar Time of last successful discovery attempt.
MESSAGE_KEY varchar Message.
MESSAGE_PARAMETERS text Values used to construct message text.
MESSAGE_PRIORITY bigint Priority of message
NET_MAP_ENTRIES bigint Number of Netmap entries found.
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Element Type Description
NODE_NAME varchar Name of server.
OPERATING_SYSTEM varchar Server operating system.
PARTNERS bigint Number of partner nodes found.
PASSWORD text Password for API connection.
PROCESSES bigint Number of Processes found to have run during Discovery.
PROTOCOL varchar Internal field for Node Discovery.
RETURN_CODE bigint Return code for Discovery.
SERVER_LICENSE text Server license text.
SERVICE_ID varchar Node or alias name.
SOURCE_PORT varchar Source port range to use for APl connection.
SRVR_LCNS_EXPRTN_D varchar Server license expiration date.
TYPE varchar Type of node.
E=Explorer node
D=Discovered node
USER_ID varchar User ID for API connection.
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Metadata Labels Table (META_DATA LABELS)

The following table describes the data fields available from the META_DATA_LABELS database
table for reports. It holds the user-provided labels for the metadata fields.

There are four rows in this table, one for each of the four metadata fields.

Element Type Description
USER_DATA_TITLE varchar Name of the metadata field.
USER_DATA_FIELD varchar User-provided label for the metadata field. The default is

User Data x, where x ranges from one to four, or
SERVER_DATA_x where x ranges from one to ten.

Default table contents are as follows:

USER_DATA_TITLE USER_DATA_FIELD
userDatalTitle User Data 1
userData2Title User Data 2
userData3Title User Data 3
userData4Title User Data 4
serverMetaDatalTitle Server Data 1
serverMetaData2Title Server Data 2
serverMetaData3Title Server Data 3
serverMetaData4Title Server Data 4
serverMetaData5Title Server Data 5
serverMetaData6Title Server Data 6
serverMetaData7Title Server Data 7
serverMetaData8Title Server Data 8
serverMetaData9Title Server Data 9
serverMetaDatalOTitle Server Data 10
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Sterling Control Center Internal Tables

The following tables are used internally by Sterling Control Center. They are not available for
third-party reporting.

4+ DURATION_MONITORS (No longer used)
TIME_MONITORS

LICENSES

CCC_INFO

CONFIG_JOBS

CONFIG_OBJECTS
CONFIG_SERVER_IDS
CONFIG_VERSIONS

AUDIT_LOG

FILE_COUNTS

R IR IR IR SR SRS
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Notices

This information was developed for products and services offered in the U.S.A.

IBM may not offer the products, services, or features discussed in this document in other countries.
Consult your local IBM representative for information on the products and services currently
available in your area. Any reference to an IBM product, program, or service is not intended to state
or imply that only that IBM product, program, or service may be used. Any functionally equivalent
product, program, or service that does not infringe any IBM intellectual property right may be used
instead. However, it is the user's responsibility to evaluate and verify the operation of any non-1IBM
product, program, or service.

IBM may have patents or pending patent applications covering subject matter described in this
document. The furnishing of this document does not grant you any license to these patents. You can
send license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation

North Castle Drive
Armonk, NY 10504-1785
U.S.A.

For license inquiries regarding double-byte character set (DBCS) information, contact the IBM
Intellectual Property Department in your country or send inquiries, in writing, to:

Intellectual Property Licensing
Legal and Intellectual Property Law
IBM Japan Ltd.

1623-14, Shimotsuruma, Yamato-shi
Kanagawa 242-8502 Japan

The following paragraph does not apply to the United Kingdom or any other country where
such provisions are inconsistent with local law: INTERNATIONAL BUSINESS MACHINES
CORPORATION PROVIDES THIS PUBLICATION "AS IS" WITHOUT WARRANTY OF
ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS
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Notices

124

FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer of express or implied
warranties in certain transactions, therefore, this statement may not apply to you.

This information could include technical inaccuracies or typographical errors. Changes are
periodically made to the information herein; these changes will be incorporated in new editions of
the publication. IBM may make improvements and/or changes in the product(s) and/or the
program(s) described in this publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for convenience only and do
not in any manner serve as an endorsement of those Web sites. The materials at those Web sites are
not part of the materials for this IBM product and use of those Web sites is at your own risk.

IBM may use or distribute any of the information you supply in any way it believes appropriate
without incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose of enabling: (i) the
exchange of information between independently created programs and other programs (including
this one) and (ii) the mutual use of the information which has been exchanged, should contact:

IBM Corporation

JABA/GA

555 Bailey Avenue

San Jose, CA__95141-1003
US.A.

Such information may be available, subject to appropriate terms and conditions, including in some
cases, payment of a fee.

The licensed program described in this document and all licensed material available for it are
provided by IBM under terms of the IBM Customer Agreement, IBM International Program
License Agreement or any equivalent agreement between us.

Any performance data contained herein was determined in a controlled environment. Therefore, the
results obtained in other operating environments may vary significantly. Some measurements may
have been made on development-level systems and there is no guarantee that these measurements
will be the same on generally available systems. Furthermore, some measurements may have been
estimated through extrapolation. Actual results may vary. Users of this document should verify the
applicable data for their specific environment.

Information concerning non-1BM products was obtained from the suppliers of those products, their
published announcements or other publicly available sources. IBM has not tested those products
and cannot confirm the accuracy of performance, compatibility or any other claims related to
non-1BM products. Questions on the capabilities of non-IBM products should be addressed to the
suppliers of those products.

All statements regarding IBM's future direction or intent are subject to change or withdrawal
without notice, and represent goals and objectives only.

This information is for planning purposes only. The information herein is subject to change before
the products described become available. This information contains examples of data and reports
used in daily business operations. To illustrate them as completely as possible, the examples include
the names of individuals, companies, brands, and products. All of these names are ficticious and
any similarity to the names and addresses used by an actual business enterprise is entirely
coincidental.
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Notices

COPYRIGHT LICENSE:

This information contains sample application programs in source language, which illustrate
programming techniques on various operating platforms. You may copy, modify, and distribute
these sample programs in any form without payment to IBM, for the purposes of developing, using,
marketing or distributing application programs conforming to the application programming
interface for the operating platform for which the sample programs are written. These examples
have not been thoroughly tested under all conditions. IBM, therefore, cannot guarantee or imply
reliability, serviceability, or function of these programs. The sample programs are provided "AS
IS", without warranty of any kind. IBM shall not be liable for any damages arising out of your use
of the sample programs.

Each copy or any portion of these sample programs or any derivative work, must include a
copyright notice as follows:

© IBM 2011. Portions of this code are derived from IBM Corp. Sample Programs.
© Copyright IBM Corp. 2011.

If you are viewing this information softcopy, the photographs and color illustrations may not
appear.

Trademarks

IBM, the IBM logo, and ibm.com are trademarks or registered trademarks of International Business
Machines Corp., registered in many jurisdictions worldwide. Other product and service names
might be trademarks of IBM or other companies. A current list of IBM trademarks is available on
the Web at “Copyright and trademark information” at www.ibm.com/legal/copytrade.shtml.

Adobe, the Adobe logo, PostScript, and the PostScript logo are either registered trademarks or
trademarks of Adobe Systems Incorporated in the United States, and/or other countries.

IT Infrastructure Library is a registered trademark of the Central Computer and
Telecommunications Agency which is now part of the Office of Government Commerce.

Intel, Intel logo, Intel Inside, Intel Inside logo, Intel Centrino, Intel Centrino logo, Celeron, Intel
Xeon, Intel SpeedStep, Itanium, and Pentium are trademarks or registered trademarks of Intel
Corporation or its subsidiaries in the United States and other countries.

Linux is a registered trademark of Linus Torvalds in the United States, other countries, or both.

Microsoft, Windows, Windows NT, and the Windows logo are trademarks of Microsoft
Corporation in the United States, other countries, or both.

ITIL is aregistered trademark, and a registered community trademark of the Office of Government
Commerce, and is registered in the U.S. Patent and Trademark Office.

UNIX is a registered trademark of The Open Group in the United States and other countries.

Java and all Java-based trademarks and logos are trademarks or registered trademarks of Oracle
and/or its affiliates.

Cell Broadband Engine is a trademark of Sony Computer Entertainment, Inc. in the United States,
other countries, or both and is used under license therefrom.

Linear Tape-Open, LTO, the LTO Logo, Ultrium and the Ultrium Logo are trademarks of HP, IBM
Corp. and Quantum in the U.S. and other countries.
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Notices

Connect Control Center®, Connect:Direct®, Connect:Enterprise, Gentran®, Gentran:Basic®,
Gentran:Control®, Gentran:Director®, Gentran:Plus®, Gentran:Realtime®, Gentran:Server®,
Gentran:Viewpoint®, Sterling Commerce™, Sterling Information Broker®, and Sterling
Integrator® are trademarks or registered trademarks of Sterling Commerce, Inc., an IBM Company.

Other company, product, and service names may be trademarks or service marks of others.
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